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1.  QUALITY ASSURANCE 
 

1.1. UNIT DESCRIPTION 
 

1.1.1. The Forensic Biology Unit must be staffed by a minimum of two of qualified analysts. 
  

1.1.1.1. If the unit is staffed by fewer than two qualified analysts the laboratory will seek to outsource 
requests for serology and DNA analysis until the unit is sufficiently staffed to resume issuing 
reports. 

  
1.1.2.  The unit must have a DNA Technical Manager (DNA Technical Leader) and a CODIS Administrator. 

 
1.1.3. The unit structure and its place within the San Diego Police Department Crime Laboratory will be 

detailed in the Department organizational chart. 
 

1.1.4. The Forensic Biology laboratory will be divided into three distinct analytical areas: a laboratory area 
which used for the purposes of screening items of evidence and the DNA extraction process; an area 
dedicated to PCR setup; and a separate area dedicated to the preparation and analysis of amplified 
DNA.   

 
1.2. UNIT FUNCTIONS 
  

1.2.1. The Forensic Biology Unit’s primary duties will be to analyze items of physical evidence to locate and 
identify biological material, and perform DNA analysis on that biological material. 
  

1.2.2. The serological testing capabilities of the Forensic Biology Unit will include presumptive and (where 
possible) confirmatory tests for components of blood, semen, and saliva.  

 
1.2.3. The DNA testing capabilities of the Forensic Biology Unit will include both autosomal and Y-

chromosome STR DNA testing. 
 

1.2.4. Any additional testing methods performed on forensic casework must be validated prior to use. 
 

1.2.5. Additional duties performed by the Forensic Biology Unit include courtroom testimony, and crime 
scene reconstruction. 
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1.3. PERSONNEL AND JOB DESCRIPTIONS 

  
1.3.1. The SDPD Forensic Biology Unit will use the date hired/transferred into Forensic Biology to determine 

what coursework and/or training is needed for DNA Technical Lead, CODIS Administrator, and 
analysts for the purposes of meeting the qualification requirements of the FBI Director’s Quality 
Assurance Standards for DNA Testing Laboratories. 

 
1.3.2. SUPERVISING CRIMINALIST 

 
The Supervising Criminalist of the Forensic Biology Unit will oversee the Forensic Biology Unit and analysts.  
The responsibilities will include assigning casework, interacting with attorneys and detectives to determine 
case priorities, reviewing the work of all assigned analysts, and monitoring the overall job performance of 
analysts.  
 
Duties and responsibilities: (The duties of Supervising Criminalist and DNA Technical Manager may be 
assigned to a single person.) 
 
A. Establishes casework priorities based on negotiations and discussions with investigators and district 

attorneys. 
 
B. Assigns casework to analysts. 
 
C. Reviews reports and examines case notes. 
 
D. Reviews and evaluates the performance of subordinates. 
 
E. Works with the DNA Technical Manager to review and establish Unit specific policies and analytical 

procedures when appropriate. 
 
F. Interviews and hires new employees. 
 
G. Trains the new employees on department policies and procedures. 
 
H. Works with the DNA Technical Manager to coordinate analyst training.  
 
I. Keeps track of workload statistics. 
 
J. Prepares budget requests. 
 
K. Holds Unit meetings to disseminate department, laboratory, or unit specific information. 
 
L. Prepares reports as required by the Crime Laboratory Management.  
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1.3.3. DNA TECHNICAL MANAGER 
 

Duties and responsibilities:  
 
A. Responsible for the technical operation of the laboratory as outlined in the FBI Director’s Quality 

Assurance Standards for DNA Testing Laboratories. 
 
B. Authority to initiate, suspend, and resume technical operations for the laboratory or an individual. 

 
C. Reviewing, revising and approving any DNA-related technical policy or procedure prior to final 

issuance by the Quality Manager. 
 

D. Overseeing, reviewing and approving DNA method validation or modification, including completion of 
validation documentation, prior to final approval by Quality Manager. 

 
E. Overseeing and approving training of DNA analysts, laboratory technicians, and technical reviewers in 

DNA analytical procedures, including completion of training documentation. This includes reviewing, 
verifying, and approving the academic transcripts for newly qualified analysts and technical reviewers. 

 
F. Approving the technical specifications for outsourcing agreements. 

 
G. Reviewing internal and external DNA Audit documents, and if applicable, approve any Corrective 

Action reports involving a DNA technical issue. 
  

H. Reviewing the policies and procedures of the DNA Unit on an annual basis. 
 

I. Reviewing and approving the training, quality assurance, and proficiency testing programs in the DNA 
Unit. 
  

J. Acting as a technical reference for the Quality Manager. 
 
K. Performing some technical reviews of DNA case files. 
 
L. Acting as a mediator when necessary in the technical review of DNA casework in the Forensic Biology 

Unit. 
 
M. Providing technical consultation as needed to the members of the Forensic Biology Unit. 
 
N. Working with Supervising Criminalists and Quality Manager to ensure compliance of the DNA analysts 

with QA and unit policies and procedures. 
 
O. Conducting casework analysis. 
 
P. Prepares reports as required by the Crime Laboratory Management. 
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1.3.4. CODIS ADMINISTRATOR 
 

Duties and responsibilities:  
 

A. Oversees the security and integrity of the local CODIS network. 
  

B. Authority to terminate an analyst’s or the laboratory’s participation in CODIS until the reliability and 
security of the computer data can be assured in the event an issue with the data is identified. 
  

C. Oversees the entering of DNA profiles from casework into the local database. 
 

D. Ensures that DNA profiles are searched appropriately against the CODIS databases. 
 

E. Schedules and documents the CODIS computer training of casework analysts. 
 

F. Ensures that the security of data stored in CODIS is in accordance with state and/or federal law and NDIS 
operational procedures. 

 
G. Ensures that the quality of data stored in CODIS is in accordance with state and/or federal law and NDIS 

operational procedures. 
 

H. Ensures that matches are dispositioned in accordance with NDIS operational procedures.    
 

I. Ensures upgrades to the CODIS software are performed as required by NDIS.   
 

J. Schedules and documents the yearly training in NDIS eligibility. 
 

K. Disseminates CODIS information to the rest of the Forensic Biology Unit. 
 
 

1.3.5. CRIMINALIST (I AND II) 
 

The job descriptions for Criminalist I and II are similar except that Criminalist II duties may be more extensive 
and Criminalist II analysts are expected to work more independently.  In addition to the normal educational 
requirements of the Criminalist position, DNA Criminalists must complete college-level classes in 
Biochemistry, Molecular Biology, Genetics, and Statistics and/or Population Biology.  

 
Criminalist I and II’s primary duties involve locating and identifying biological material on items of physical 
evidence and performing DNA analysis.  Analysts are required to document all exams, tests, observations, 
results, summarize the findings in a written report, and if necessary, testify in courts of law. 

 
Duties and responsibilities: 
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A. Receives, inventories, screens, and preserves items of physical evidence. 
 
B. Locates and identifies biological material.  
 
C. Conducts DNA analysis to determine possible associations between the evidence and any reference 

samples provided. 
 
D. Writes reports summarizing the findings and provide expert testimony in court. 
 
E. Remains technically current and knowledgeable in appropriate analytical methods. 
 
F. Participates in the evaluation and validation of new technologies or methodologies. 
 
G. Participates in any special projects as assigned by the Supervising Criminalist or Laboratory Manager. 
 
H. Informs the Supervising Criminalist or DNA Technical Manager of problems that develop at any stage of a 

case. 
 
I. Uses the technical manual, unit policies manual and general quality assurance manual to deal with any 

procedural question or analytical method. 
 
 

1.3.6. LABORATORY TECHNICIAN 
 

The laboratory technician functions as a support position for the Forensic Biology Unit.  Duties include 
ordering supplies, calibrating instruments, monitoring operating temperature of equipment, performing 
routine maintenance of equipment, and cleaning the unit on a weekly schedule.  The laboratory technician 
maintains a database of all chemicals ordered by the Unit.  If the position of Laboratory Technician is unfilled 
the duties and responsibilities will be shared among current employees. Certain functions described above may 
be performed by volunteers or interns but only under the direct supervision of the laboratory technician or 
other qualified analyst. 

 
Duties and responsibilities: 

 
A. Checks the calibration of instruments such as pipettes, thermal cyclers, and balances. 
 
B. Orders chemicals and supplies for Forensic Biology  
 
C. Maintains an accurate inventory of all chemicals located in the Unit. 
 
D. Ensures that laboratory instruments, communal work areas, and floors are cleaned and decontaminated. 
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E. Ensures that the operating temperatures of the Unit ovens, incubators, refrigerators, and freezers are 
monitored. 

 
F. Ensures that biological evidence collection kits and reference mouth swab kits are prepared for 

departmental use or for the collection of evidence at area hospitals. 
 
G. Performs other tasks as assigned by the Supervising Criminalist. 

 
 

1.3.7. INTERN/VOLUNTEERS 
 

Interns (students) and volunteers (non-students) will assist the Unit by performing certain clerical duties, 
cleaning the laboratory work areas and monitoring the operating temperature of equipment.  These activities 
will always be performed under the guidance of the Laboratory Technician or Criminalist.  The Laboratory 
Technician is ultimately responsible for making certain any duties completed by the interns and volunteers are 
performed correctly.   

 
Depending on the experience level of an intern or volunteer they may also be involved in laboratory projects 
such as the validation of new technologies. This validation work will always be performed after receiving the 
appropriate training and qualifying tests, and under the supervision of the DNA Technical Manager. 
 
 

1.4. TRAINING PROGRAM  
  

1.4.1. The training program information will be maintained in the Forensic Biology Training Program 
Manual. 

  
1.4.1.1. Documentation of training program completion will be maintained by the Quality 

Manager. 
  

1.4.1.2. Documentation of training and competency for new methods will be maintained by the 
Quality Manager. 

  
1.4.2. Each analyst will be provided 8 hours (cumulative minimum) of documented training (i.e., continuing 

education) per year in subject areas relevant to the development in DNA typing. 
  

1.4.2.1. Documentation of completed continuing education will be maintained by the DNA 
Technical Manager. 
  

1.4.2.2. Documentation of internal training will include: 
 

1.4.2.2.1. Title of the training presentation/program; 
1.4.2.2.2. A copy of the presentation/training provided; 
1.4.2.2.3. Date of the training/presentation; 
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1.4.2.2.4. Attendance list; 
1.4.2.2.5. Hours of training; and  
1.4.2.2.6. If the presenter is external to the laboratory, the presenter’s CV. (Note that 

trainers internal to the Crime Laboratory have their SOQs on file in 
PowerDMS). 

 
1.4.2.3. Participation and completion of programs based on multimedia or internet delivery must be 

formally recorded and approved by the DNA Technical Manager. 
 
 
1.5. LITERATURE REVIEW 

  
1.5.1. Annual review of scientific literature will be documented within the laboratory’s document 

management system (i.e., PowerDMS).  
  

1.5.2. Analysts within the Forensic Biology Unit will be provided copies of relevant literature (at least one 
full article, abstracts, or miscellaneous publications) periodically throughout the year. 

 
 
1.6. TECHNICAL LEAD CONTINGENCY PLAN 
  

1.6.1. The Forensic Biology Unit of the San Diego Police Department currently employs multiple analysts 
who meet the requirements to be DNA Technical Manager. In the event of a vacancy in the DNA 
Technical Manager position the Crime Laboratory Management will interview the candidates and 
appoint a person to fill the vacancy. 

 
 

1.7. NON-CONFORMING WORK 
  

1.7.1. Quality Incident Summary forms (FB network H:\Worksheets\QA Worksheets) will be completed 
by analysts for: 
 any malfunction or problem with laboratory equipment,  
 when control samples fail to provide the expected results,  
 when a technical policy or procedure was violated in the process of analysis, or  
 when a potential association is made to the elimination DNA database. 
  

1.7.2. Quality Incident Summaries will address the following (if applicable): 
 

1.7.2.1. Definition and evaluation of the non-conformance 
1.7.2.2. Actions Taken to address the non-conformance 
1.7.2.3. Root cause (if determined) 
1.7.2.4. Reported results opinions or interpretations 

 
1.7.3. Quality Incident Summaries will be submitted to the DNA Technical Manager, or designee, for 

further evaluation. If corrective actions are required, as defined in section 8.7 of the Quality Manual, 
the Quality Manager will be notified. 
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1.7.3.1. Non-conformances will be evaluated to determine its significance or impact on the current 

analysis. 
1.7.3.2. Non-conformances will be evaluated to determine its significance or impact to previous 

analysis. The Quality Manager will be notified if previous work is deemed to be affected. 
1.7.3.3. Appropriate actions will be taken to remediate non-conformances. Appropriate actions will 

be determined based on 1.5.3.1 and 1.5.3.2.  
 

1.7.4. Quality Incident Summaries will be tracked to identify trends. If a trend is identified, the Quality 
Manager will be notified. 

 
1.7.5. Non-conformances involving failed controls or potential associations with the elimination DNA 

database with likelihood ratio HPD values greater than 99 will be disclosed in the report. 
 
 
1.8. PROFICIENCY TESTING 
 
Please refer to the Laboratory Quality Manual for additional information on the proficiency testing Program. 

1.8.1. Each DNA analyst in the Forensic Biology Unit must complete two external DNA proficiency tests in 
each calendar year with an interval between the tests of no less than four months and no more than 
eight months. 
  

1.8.2. The due date of the proficiency test (as listed by the provider) will be the date by which proficiency 
tests are tracked.  

 
1.8.3. At least one proficiency test per year will involve body fluid identification. 

 
1.8.4. Proficiency tests will be worked in the same manner as casework and undergo both technical and 

administrative review. 
 

1.8.5. Autosomal STR and YSTR testing (for those qualified) must be run on each semiannual proficiency 
test. 

 
1.8.6. YSTR testing must be performed on each sample that has male DNA detected. 

 
Note:  If a sample containing male DNA has multiple fractions (i.e., sperm and non-sperm fractions), only one 
fraction must have YSTR testing performed on it. 

 
1.8.7. Analysts must enter into the proficiency testing program within 6 months of completion of the 

training program. 
 

1.8.8. The DNA Technical Manager will compare the results obtained by each analyst to the consensus 
results from the test provider, determine the outcome of the test, and inform analysts of the 
outcome. 
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1.8.9. Analysts will initial their proficiency test packets, acknowledging the outcome of the test. 
 

1.8.10. Proficiency tests will be maintained by the Quality Manager. 
 
 

1.9. FORENSIC BIOLOGY COMPUTER NETWORK SYSTEM 
 

The Forensic Biology Unit employs an independent network system comprised of several servers and client 
computers to share electronic data among criminalists, link instrumentation, maintain a centralized storage of 
data, and provide a secure connection to the Combined DNA Index System (CODIS). 

 
1.9.1. ELECTRONIC DATA STORAGE 

 
Data backup is performed automatically and is managed through the Data Systems Department of the San 
Diego Police Department.  Please contact SDPD Data Systems for additional information regarding the 
management and security of the Forensic Biology computer network. 

 
 
1.10. QUALITY CONTROL AND CRITICAL REAGENTS 

  
1.10.1. The following list contains the reagents deemed critical to the DNA testing process: 

 

 All reagents used in the extraction of DNA (excluding dithiothreitol (DTT)) 
 Qiagen DNA Investigator and QiaSymphony DNA Investigator Kits 
 All Quantifiler qPCR Kits 
 All Autosomal or Y-chromosome STR Typing Kits 

 
1.10.2. SAMPLES AVAILABLE FOR QUALITY CONTROL TESTING 

 
Only samples with known DNA profile results will be used to assess critical reagents.  Extraction reagents will 
be quality tested using dried blood samples. DNA typing and quantification kits will be quality tested using 
previously extracted DNA samples. 
 
1.10.3. QUALITY CONTROL TESTING OF CRITICAL REAGENTS 

  
1.10.3.1. Before any critical reagent can be used for casework analysis it must undergo quality control 

testing. 
  

1.10.3.2. Quality control analysis will undergo technical review and review by the DNA technical 
Manager, or designee. 

 
1.10.3.3. The results of controls, NIST SRM, and known samples must be in complete agreement with 

their expected results order for a critical reagent to pass QC. 
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1.10.3.4. In the event that the QC data does not pass, a second QC analysis will be used to confirm the 
original result.   

 
1.10.3.4.1. If the second QC analysis demonstrates the reliability of the kit, it may be used for 

casework analysis. 
  
1.10.3.4.2. If the second QC confirms a problem with the critical reagent, then the critical reagents 

tested will not be approved for casework and, if applicable, the vendor of the reagent will 
be contacted. 

 
1.10.3.5. Critical reagents/kits will be tested as follows: 

 
Extraction Reagents:  Two different known samples and a reagent blank will be carried through DNA extraction 
and typing.  The preparation dates of the reagents and the results of the DNA testing will be documented on 
the Quality Control Worksheet for Critical Extraction Reagents.   
 
Qiagen (EZ1 or QIAsymphony) DNA Investigator kits:  Two different known samples and a several concentrated 
(note: concentration factor not to exceed 8x) reagent blanks (for EZ1 only: some eluted in TE and some 
eluted in water) will be carried through DNA extraction and typing.  The kit, reagent strip lot numbers, and 
the results of the DNA testing will be documented on the Quality Control Worksheet for DNA Investigator 
kits. 
  
Quantifiler Duo kits:  The DNA standard tubes from the new lot of Quantifiler Duo kits should be defrosted, 
pooled, and re-distributed into the DNA standard tubes.  The new lot of kits should be used to quantify 
calibrators 1 and 2 from the old lot of kits as well as three replicates of calibrators made with the current lot of 
kits.  Two samples with known genotypes should also be quantified using the new Quantifiler Duo kit(s), the 
obtained quant values should be used to amplify those samples (and appropriate controls) using one of the 
validated typing kits.  All samples should produce the known genotypes and the peak heights should generally 
be consistent with expectations based on the input amount of DNA.  The target volume of the QC samples 
will be determined based on the quantification value obtained from the new Quantifiler Duo Kit.  Successful 
typing of the known samples will serve to demonstrate the reliability of the new kit lot(s).  
 
GlobalFiler DNA typing kits:  007 Control DNA should be defrosted, pooled, and re-distributed into the DNA 
standard tubes prior to performing the QC testing. Two known samples will be typed along with the 007 
Control DNA positive control and an amplification blank.  The lot numbers of all kit components and the 
results of the DNA testing will be documented on the Quality Control Worksheet for GlobalFiler.    (See also 
the NIST Testing policy below) 
 
Yfiler Plus DNA typing kits:  New kit lots will be tested with two known male samples, the 007 DNA positive 
amplification control, and an amplification blank.  The lot numbers of all kit components and the results of the 
DNA testing will be documented on the Quality Control Worksheet for Yfiler.   
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All QC data will be stored electronically on the FB network.  
 

1.11. NIST TESTING OF DNA PROCEDURES 
 

NIST Standard Reference Material or NIST-traceable samples will be used when validating new quantification 
kits or DNA typing kits. 

 
1.12. EQUIPMENT VERIFICATIONS 

  
1.12.1. New critical equipment (1.12.2) will require validation, or verification prior to implementation 

into casework. 
  
1.12.2. Verifications will be performed on the equipment that has been identified as critical to the analysis 

of samples in the Forensic Biology Unit.  The equipment listed below will be assessed at the 
approximate intervals indicated. If any of the instruments in the list is taken out of service a 
verification will be performed prior to re-initiating casework on the instrument. 

 

Equipment Item Location Schedule (approximate) 

Pipettes 
Forensic Biology Main Lab, PCR Setup, and 
Amplification Room 

Every six months 

Balances 
Forensic Biology Main Lab 
and Amplification Room 

Annually 

Thermomixers Forensic Biology Main Lab Every six months 

BioRobot EZ1s Volume Test Forensic Biology Main Lab Every six months 

QIAsymphony Forensic Biology Main Lab Annually 

QIAcubes Forensic Biology Main Lab Annually 
Hamilton Nimbus Forensic Biology PCR Setup Every six months 

Thermal cyclers Amplification Room Every six months 

SDS 7500 
Block Contamination Check 
All other calibrations 

Amplification Room 
 
Every six months 
Annually 

Genetic Analyzers Amplification Room Annually 

Corbett CAS-1200/QIAgility Amplification Room Annually 

 
See the equipment maintenance section for additional information on equipment care. 

 
1.12.3. Pipettes will be verified by an external service provider based on the pipette manufacturer’s 

systematic (accuracy) and random (precision) error tolerances. 
  

1.12.4. VERIFICATIONS 
 

If any maintenance, repair, or service is conducted on a piece of equipment, a performance verification will 
be performed. 
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1.12.4.1. QIAcubes - preventive maintenance will be performed on the instrument on a yearly basis. 
After any service visit, including the yearly preventive maintenance, the QIAcube(s) will be 
evaluated with a performance verification. This verification will aim to establish if the 
instrument performance is acceptable for casework applications. This is accomplished by 
determining if the service issues were corrected and that the instrument(s) can still perform 
the methods as expected. One way of determining this is to run a set of mixed sperm/non-
sperm cell samples through the QIAcube and continue the analysis through both quantification, 
amplification, and CE analysis. Satisfactory performance will be determined by the ability to 
separate the sperm and non-sperm fractions of the verification samples. 
  

1.12.4.2. BioRobot EZ1s – every six months a volume test will be conducted on all BioRobot EZ1s to 
determine whether pipetting performance is still optimal. See the equipment maintenance 
protocols section (section 6) for additional information. A passing result must be within 5% of 
the pipetted volume for all channels within the instrument. 

 
1.12.4.3. QIAsymphony - preventive maintenance will be performed on the instrument on a yearly 

basis. As part of the preventive maintenance visit, the pipetting accuracy and precision are 
checked for all 4 channels. After any service visit, including the yearly preventive maintenance, 
the QIAsymphony will be evaluated with a performance verification. This verification will aim 
to establish if the instrument performance is acceptable for casework applications. This is 
accomplished by determining if the service issues were corrected and that the instrument(s) 
can still perform the methods as expected. One way of determining this is to run a set of 
samples purified on the QIAsymphony through both quantification set-up and amplification 
setup protocols. Replicate samples could also be run on the BioRobot EZ1(s) to demonstrate 
satisfactory performance. 

 
1.12.4.4. Hamilton Nimbus – preventive maintenance will be performed on the Nimbus instruments 

approximately every 6 months. As part of the preventive maintenance visit, the pipetting 
accuracy and precision are checked for all 4 channels. This is documented in the volume 
verification report.  

 
After any service visit, including the yearly preventive maintenance, the Nimbus instruments 
will be evaluated with a performance verification. This verification will aim to establish if the 
instrument performance is acceptable for casework applications. This is accomplished by 
determining if the service issues were corrected and that the instrument(s) can still perform 
the methods as expected. One way of determining this is to run a set of samples through both 
quantification setup and amplification setup protocols. Replicate samples may be used to assess 
pipetting volume accuracy and precision during the quantification setup.  
 
Any changes to the methods (i.e., robotic instructions underlying the procedure) will require a 
modification study to determine whether the changes have adversely affected performance. 

 
1.12.4.5. Genetic Analyzers - the QC analysis of critical reagents will serve as the annual performance 

verification of the Genetic Analyzers.  The QC runs performed for the various testing kits 
employed by the lab will be rotated through the various Genetic Analyzers throughout the 
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course of the year. Performance checks separate from QC runs may also be done using a 
minimum of the amplification positive, amplification negative and allelic ladder.  
 
After any service visit, including the yearly preventive maintenance, genetic analyzers will be 
evaluated with a performance verification. This verification will aim to establish if the 
instrument performance is acceptable for casework applications. This is accomplished by 
determining if the service issues were corrected (if applicable), electrophoresis capabilities 
(i.e., resolution) are acceptable, and that the sensitivity of the instrument has not been altered 
substantially. One way of determining this would be to evaluate data from a set of samples run 
pre-service and comparing it to data from the same samples run post-service. 
  

1.12.4.6. Corbett CAS-1200/QIAgility – the performance check of the CAS-1200 will consist of an 
evaluation of the instruments pipetting against manual pipetting of the same samples.  This will 
be accomplished based on the CAS-1200 pipetting of a known set of replicate samples for 
analysis on the genetic analyzer.  The results of the replicate CAS-1200 pipetted samples will 
be compared against the same replicate samples prepared manually.  Total detected peak 
heights of both sets of samples will be used to measure the performance of the CAS-1200.  
Although several variables will affect the ultimate peak heights on the 3500, ideally the 
difference between the total peak heights both sets of samples should be less than 10%. 

 
1.13. POLICY FOR MONITORING INCUBATORS, REFRIGERATORS, AND FREEZERS 

 
The incubators, refrigerators, and freezers in the Forensic Biology Unit will be monitored approximately every 
week.  The operating temperatures should be recorded on a worksheet attached to the equipment.  Refrigerators 
will be expected to operate at a temperature between 1 to 13oC and freezers at a temperature colder than -10oC.  
Consistent deviations from the expected temperature indicate that maintenance or repair is likely required and 
the Supervising Criminalist of the unit will be notified. 

 
1.13.1. MICROSCOPES 

 
The microscopes in the Forensic Biology Unit will be maintained according to policies outlined in the 
laboratory Quality Systems Manual. 
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1.14. QUALITY ASSURANCE DOCUMENTATION IN THE FORENSIC BIOLOGY UNIT 
 

This list below indicates all the logs maintained by the Forensic Biology Unit: 
 

Log Name Location 

Kit Receipt Log Electronic 

Reagent Preparation Logs Electronic 

Supply Order Log Electronic 

DNA Extraction  Electronic 

Qiagen Robot Reagent QC Electronic 

GlobalFiler QC Electronic 

Y-STR QC Electronic 

Quantifiler Duo QC Electronic 

Unexpected Results Electronic 

FB Incident Log Electronic 

Staff Associations Electronic 

Balance Calibration Tests (Quarterly) Electronic 

Pipette Calibration Electronic 

Nimbus Maintenance Electronic 
Thermal Cycler Calibration & Uniformity Electronic 

3500 Maintenance Electronic 
Ovens & Fridges Temperature Log Electronic 

Qiagen EZ1 Volume Test Electronic 

QIAsymphony maintenance Electronic 

QIAcube Maintenance  Electronic 
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2.  TECHNICAL RECORDS  
  

2.1. REPORT FORMAT 
 

The Biology Unit will use the standardized report format located in the Quality Manual.  Where available, CII 
numbers will be included in the report. 

 
2.1.1. BACKGROUND SECTION 

  
2.1.1.1. A background section of the report will only be used for: 

  
2.1.1.1.1. Describing corrections to, and referencing, original reports in Report Amendments; or, 

  
2.1.1.1.2. Referencing external data used to render conclusions in the report.  

 
 

2.1.2. CASE-TO-CASE HIT NOTIFICATIONS 
  

2.1.2.1. Will be issued for any new associations between evidence items in different cases, or to 
individuals in multiple cases.  
  

2.1.2.2. Are required when any SDPD cases have been associated through the database to: 
 

2.1.2.2.1. Any other SDPD case; 
2.1.2.2.2. Cases from an outside agencies; 
2.1.2.2.3. A named individual.  

 
2.1.2.3. Do not require technical review, but must be administratively reviewed prior to issuance. 

 
2.1.2.4. The process for case-to-case notifications will be: 

 
2.1.2.4.1. FB analysts will issue case-to-case notifications in the following scenarios: 

  
2.1.2.4.1.1. Associations to cases without a named individual. 
2.1.2.4.1.2. Associations to individuals without CII or FBI identification numbers. 

  
2.1.2.4.2. FB Laboratory Technician (or other designee) will issue case-to-case notifications when 

associations to named individuals with CII or FBI identification number are made.  
 

   
2.1.3. SCREENING REPORTS 

 
Screening results can be summarized either through the inclusion of a table or through written 
explanations of the results. 
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2.2. TECHNICAL RECORDS 
  
2.2.1. The technical record assembled by the analyst will contain the original of the final signed report, the 

work request(s), any communications or documentation directly relevant to testing, and the complete 
analytical record (or a reference as to where the data is located). 
  

2.2.1.1. When testing information from a separate case is relied upon for interpretations within a 
technical record (e.g., a reference sample worked as part of a different case), a pink worksheet 
indicating where the information originated will be included as a numbered page of the 
technical record. 
 

2.2.1.2. This pink sheet will serve to notify clerical that additional material is required in the event of a 
discovery request. 

 
2.2.1.3. Documentation that does not directly pertain to the technical record (i.e., that does not direct 

testing, indicate or specify the items to be tested, or is not related to testing activities 
performed within the analytical record (see below) will not be included as part of the 
numbered pages of the record. 

  
2.2.2. The technical record will subject to both technical and administrative reviews. 

 
2.2.3. ANALYTICAL RECORD 

 
2.2.3.1. The analytical record will contain the following (as applicable): 

  
2.2.3.1.1. Pink sheet indicating the case #(s) for any information relied upon not part of the 

current analysis (see 2.2.1.1 and 2.2.1.2) 
2.2.3.1.2. Request for analysis 
2.2.3.1.3. Documentation of task-relevant communications 
2.2.3.1.4. Evidence inventory and analysis notes, including any serology tests results 
2.2.3.1.5. DNA extraction, quantification, amplification, and capillary electrophoresis notes (or a 

reference to where that information may be found) 
2.2.3.1.6. DNA results (electropherograms) 
2.2.3.1.7. Interpretation information/worksheets 
2.2.3.1.8. STRmix results page with diagnostic information of the MCMC 
2.2.3.1.9. Statistical evaluations 
2.2.3.1.10. HdTT evaluations for any association deemed investigatively relevant 
2.2.3.1.11. CODIS worksheet printouts for any samples to be uploaded to CODIS 
2.2.3.1.12. Disposition information for derivative evidence and work product 

 
2.2.4. CASEWORK BATCHING 

  
2.2.4.1. Analysts may group the analytical records for multiple cases together into a single analytical 

record called an analytical batch. 
 
2.2.4.2. Each case in the casework batch must receive its own individual report. 
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2.2.4.3. Technical and administrative reviews will be conducted on analytical batches.  
 
2.2.4.4. Completed analytical batches must be stored electronically on the FB network such that they 

are available when the technical records that rely on them are reviewed. 
 

2.2.5. NOTETAKING 
  

2.2.5.1. Notes will be taken contemporaneously with examinations or analysis.  
  

2.2.5.2. The analyst will take notes with the expectation that they, a technical reviewer, or other 
person with foundational knowledge will be able to reconstruct what was done in terms of 
examinations conducted, results obtained, testing completed, and any sampling. 
  

2.2.5.3. Page numbers and analyst initials will appear on each page of the technical record. 
 

2.2.5.4. Technical record pages will reflect the date upon which the laboratory activities were 
conducted.  

 
Note: Emails, electropherograms, and STRmix report pages that contain dates do not require 
additional dates on them unless notations are made after the initial printing/interpretation of 
the data. 

 
2.2.5.5. Analysts should avoid using the names of victims of sexual assault or child abuse cases on 

worksheets containing information from multiple cases to reduce the risk of the information 
being revealed through the discovery process for unrelated cases. 

 
2.2.5.6. The condition of evidence packaging will be noted (e.g., damaged, unsealed, etc.) when 

evidence is retrieved from the Property Room or Laboratory Vault. 
 

2.2.5.7. Photographs will be labeled with a descriptor unless it is completely evident what the 
photograph represents.  Photographs should include scale. 

 
2.2.5.8. Digital photographs taken in the Forensic Biology Unit will be archived so that they can be 

easily retrieved, if needed, for discovery. At a minimum, the electronic files of the 
photographs should be saved with the barcode of the item in the file name in a folder labeled 
with the case number. 

 
2.2.5.9. Any assumptions used will be documented in the technical record. The determination of the 

number of contributors must be on the electropherogram, and for mixtures, the locus/loci 
upon which the number of contributors determination is based must be also be included. 

 

2.3. INTERPRETATION OF CONTROLS 
 

2.3.1. SUBSTRATE CONTROLS 
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For any analysis, a result obtained from a questioned stain is interpreted as being representative of the stain 
when the result from the substrate control is negative. 
 
Results from questioned stains for which the substrate control yields a positive result need to be interpreted 
with caution.  A result from a questioned stain may not be representative of the stain when the substrate 
control also yields a positive result.  In this circumstance, the results obtained from the questioned stain 
need to be considered along with the results obtained from the substrate control. 
  
Some considerations for evaluating the substrate control include: 
 
A. The collection of the substrate control (e.g., was the control collected from a proven negative area?) 
 
B. Results from presumptive test versus a quantitative test.  Was the substrate control originally evaluated 

as being negative by a presumptive test, which is less specific than the confirmatory test? 
 
C. Did the substrate control give a low level DNA result versus a considerably higher level DNA result 

from the questioned stain? 
 
D. The source of the substrate.  Is there a stain on the substrate control, which was not identified 

presumptively, which could be giving the result?  It may be necessary to examine the substrate for other 
body fluids. 

 

2.3.2. DNA CONTROLS: 
 

Please refer to the Autosomal STR Interpretation Guidelines (or Y-STR Interpretation Guidelines section) 
section of the Forensic Biology Technical Manual for the policies regarding the interpretation of the 
Reagent Blanks, Positive Amplification Controls, and Negative Amplification Controls. 
 
 

2.4. CASEWORK REVIEW 
 

All casework performed by the Forensic Biology Unit is subject to both technical and administrative reviews.  
Refer to the casework review policy in the Quality Manual. 

 
2.4.1. ANALYICAL BATCH REVIEW 

  
2.4.1.1. The following list will guide analysts in providing a complete technical review of the analytical 

worksheets for a batch of samples. The review of an analytical batch is designed to streamline 
the review process by not duplicating data review. 
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Extraction Worksheets 

Appropriate volume of Digest Buffer/ Prot. K (and DTT) 

Correct Preparation date for Digest Buffer/ Prot. K (and DTT) 

Incubation time ≥ required minimum 

Appropriate elution volume 

TE or dH2O Elution box checked 

EZ1 instrument indicated for each sample 

Correct Reagent Strip Lot # 

Reagent blanks included 

EZ1, QIAsymphony, or QIAcube instrument and protocol indicated 

Quantitation Worksheets 

Correct Quantifiler Duo lot # 

7500 Instrument listed 

Setup listed 

Master Mix Preparation was accurately calculated 

Calibrators are within acceptable range 

TE Amp Blank quantification is undetermined 

All reagent blanks quantification are undetermined 

Amplification Worksheets 

Correct Amplification Kit (GlobalFiler or Yfiler Plus) lot # 

Correct TE Prep Date 

Veriti Instrument listed 

Setup listed 

Master Mix Preparation was accurately calculated 

Correct volume for Positive Control (007) added 

Correct volume for TE_Amp Blank added 

If samples combined, corresponding RBs are combined 

Correct volume for Reagent Blanks added 

Dilutions (and/or) concentration procedures listed below table 

3500 Sample Setup Worksheets 

Formamide_Blank and Formamide_ISS included 

Two ladders included 

Positive and negative control included 

Reagent blanks included 

3500 Instrument listed 

Sample setup listed 

Correct Reagent Lot #s (Formamide, ISS, Ladder) 

GeneMapper Analysis (electronically viewed) 

Sample page included in packet 

At least 1 evidence and 1 reference ladder passed (if applicable) 

Correct Sample Type selected 

Correct Analysis Method and Panel selected for Evidence and Reference 

All GS600 – Appropriate peak heights and resolution 
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Positive Control passed (correct types obtained, any additional peaks explainable) 

TE Amp Blank and all Reagent Blanks (No detected DNA types) 

If increased injections were used, controls also injected appropriately 

Administrative Review 

Date, initials, page numbers and analytical batch name on each page 

Corrections are lined out, dated, and initialed 

Analyst has corrected/ resolved all concerns raised by the tech reviewer 

Worksheets are complete 

Analytical batch technical review worksheet is complete 

 
 
  

2.4.2. TECHNICAL REVIEW 
 

2.4.2.1. Each technical record in the Forensic Biology Unit will have a technical review conducted on it 
by a second qualified analyst. 
 

2.4.2.2. Technical review will rotate between all qualified analysts in the Forensic Biology Unit to 
ensure that the duty remains equally distributed.  

 
2.4.2.3. Technical review will ensure the accuracy of the final report and that established Forensic 

Biology protocols and policies are being applied to case analysis. 
 

2.4.2.4. Technical review will ensure that the conclusions in the report are supported by the data in the 
analytical record (i.e., case notes, sketches, photos, etc.). 

 
2.4.2.5. If changes are made as a result of the technical review that affect the opinions and interpretations 

in the report, the authorization date must be updated to reflect the date of those changes. 
 

2.4.2.6. Technical review will be completed within 14 calendar days.  
 

2.4.2.6.1. Any delays that will cause this time period to be exceeded must be communicated with 
the supervisor so that alternative arrangements may be made, if necessary. 

 
2.4.2.6.2. Any requirements for rush reviews must be communicated with a supervisor so it can be 

assigned for priority review directly. 
 

2.4.2.7. Unresolved differences between the case analyst and the reviewing analyst will be mediated by 
the DNA Technical Manager. 

 
2.4.2.8. The date of the completion of the technical review will be documented below the signature 

block in the report per Quality Manual policy. 
 

2.4.2.9. The following list must be used to guide analysts in providing a complete technical review.  
The list is not meant to be all inclusive and a case needs to be evaluated in its entirety to make 
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certain that a reasonable, competent, and complete analysis was performed based upon 
documented policies and procedures. 

 
2.4.2.9.1. Technical review worksheets will not be maintained in the technical record. 

 
Notes 

DNA request has supervisor (or designee) initials 

References - justification for collection documented and/or consent form included 

All evidence and reference samples approved by supervisor (or designee) for analysis were tested 

Permission to consume evidence obtained or intent to consume communicated 

Communications concerning the case are recorded 

Notes/worksheets are complete and legible 

Case file has pink case reference sheet 
Evidence Sampling 

Written/photographic description of packaging, evidence examined, & samples collected included 

Photographs contain a scale 

Approved methods used to locate and identify biological material 

Controls used for presumptive tests 

Documentation that evidence was labeled, repackaged, and sealed 
Analytical Notes 

Completed Analytical Batch (AB) review worksheet included 

Analytical notes not part of analytical batch contain info required per AB checklist 

QIS documentation present in notes or in AB 

Appropriate template amount amplified for samples 
Electropherograms 

Electropherograms present for all relevant samples 

Multiple injections were performed where necessary. If so, results generally consistent/expected. 

Artifacts are labeled and analyst-derived allele designations accurate 
Unresolved peaks are documented with allele designation, size, and height 

Interpretation 

Reasoning regarding number of contributors is documented on electropherogram 

Correct STRmix profiling kit/injection time was used 

Conclusions based on visual comparison are documented 

Evidence (.txt) files used in MCMC accurate and complete, including unresolved peaks 

Comparisons made to all relevant reference samples and reference (.txt) files accurate and complete 

MCMC conditioned on reference(s) if supported by scenario and data/LR 

MCMC genotypes, weights, and mixture proportions meet qualitative expectations (if not, informed priors used) 

Sex determining loci checked, interpreted, and documented 

STRmix database search results evaluated using Caucasian DB 

HdTT (using all populations) run for MCMC(s) with probative associations 

No large LR disparities between loci (i.e. inclusionary LRs at all but one locus of 0) 

For Y-STRs, designation of major and minor contributors is appropriate 

For Y-STRs, appropriate comparisons were performed and conclusions drawn 
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For Y-STRs, appropriate statistical assessment of evidence performed 
CODIS 

Requests for elimination samples documented 

CODIS sheets included for applicable and eligible evidence and suspect profiles 

MME is appropriate for level of CODIS being searched 

CODIS sheets are complete and correct, including specimen category and DNA types 

For CODIS hits, LRs have been performed to assess "goodness-of-fit". 
Report 

Header is correct on all report pages 

Supplemental/Amended report designation and appropriate background included 

Evidence Examined & Opinions/Interpretations sections have correct barcodes & item descriptions 

Evidence Examined contains results of serology testing (& test details listed under table) 

Evidence Examined contains correct discontinuation code(s) and appendix reference statement 

DNA typing kit(s) listed 

Opinions/Interpretations list number of contributors and mixture proportions 

Opinions/Interpretations reflect conclusions made in notes (i.e. inclusions/exlcusions and verbal wording, all 
comparisons listed, CODIS database search statements) 

Reported LR for associations is the lowest HPD of all four populations 

Sub-sub source LR reported for inclusions with >106-fold difference between LR and HPD 

CODIS search level is indicated for each component 

Signature block is correct and complete 

Analytical batch(es) listed in report 

Information from QIS documented appropriately 

 
2.4.2.10. TECHNICAL REVIEW EXPECTATIONS 

  
2.4.2.10.1. Corrections to the notes regarding spelling or grammar can be made by the technical 

reviewer. 
  

2.4.2.10.2. Any differences of opinion that cannot be clarified during the initial back-and-forth of 
a review will be discussed in person. 

 
2.4.2.10.3. Continued disagreements will be mediated by the DNA Technical Manager. 

 
2.4.2.10.4. Continued disagreements will involve the Quality Manager or Supervising 

Criminalist. 
 

2.4.2.10.5. Analysts involved in the discussion may elect to have further discussions with the 
Crime Laboratory Management concerning the technical issue. 

 
2.4.3. ADMINISTRATIVE REVIEW  

  
2.4.3.1. The administrative review will be documented on the report per Quality Manual policy 

7.7.1.1b. 
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2.4.3.2. The total number of page number in the technical record can be completed by the 

administrative review as part of the review process. 
 

2.4.3.3. Administrative reviewers will be responsible for completing the portions of SART-on-Q 
related to the completion and issuing of the report.  

 
2.4.3.4. The following list will be used as a guide to provide a complete administrative review of case 

packets. The list is not meant to be all inclusive and a case needs to be evaluated in its entirety 
to make certain that the report and analytical record are complete. 

 
2.4.3.4.1. Administrative worksheets will not be maintained in the technical record. 

 
Notes 

Date, analyst initials and case/incident number on each page 

Corrections are made in the appropriate format 

All technical review comments/corrections have been addressed 

Every page is numbered, in order, and total number of pages indicated on 1st page 

CODIS sheets have been copied for upload 
Report 

Proper grammar, spelling, and Style Guide format 

Evidence Examined section contains all agreed upon items from request 

Disposition section included 

Analyst signature and reviewer initials are in place 

Report appendix included 
Other 

Update evidence databases as appropriate (i.e., EvidenceOnQ, SARTonQ) 

Chain of custody for all items is complete 

Sub-item designations added to comments section in EvidenceOnQ 

  

3.  EVIDENCE POLICIES 
 

3.1. The Forensic Biology Unit will accept case submissions from all investigative units within the Department. 
Case submissions will be handled as described in the Quality Manual. 

 
3.2. Any reference DNA sample requested must have a consent form submitted in order to have the sample 

analyzed, unless it has been collected: from a suspect that is a felony arrestee; by court order; from a suspect 
who is a 4th waiver subject; or from sexual assault victim as part of the SAFE kit collection. 
  

3.3. Consent forms will be maintained as a numbered page within the technical record. 
 

3.4. Analysts will adhere to the consumption of evidence policy in the Quality Manual. 
 
3.4.1. If the decision of an analyst is that consuming an item of evidence provides the best chance of 

obtaining a DNA result and there is an issue with the laboratory consuming the evidence, an analyst 
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may agree to initially consume half of the sample (predicated on the subsequent analysis of the 
remaining portion of the evidence if needed) or may suggest that an independent laboratory be 
selected to perform the analysis. 

 
3.5. VICTIM SEXUAL ASSAULT EVIDENCE SAMPLING POLICIES 

  
3.5.1. Half of SAFE kit (also referred to as SART kit) evidence swabs selected for testing will be consumed 

for initial testing (e.g., one of two swabs collected or half of a single swab). The remaining half of any 
evidence swabs may be sampled (if needed - see section 3.10.5.3.1 in the discontinuation policy 
section) in accordance with the laboratory’s consumption of evidence policies. 
  

3.5.2. Supervisor permission must be obtained to select alternative swabs to any of the ones specifically listed 
below if they are not present in the SAFE kit (e.g., for example, supervisor permission must be 
obtained to sample vestibular swabs if no external genital swabs are present in the kit). 
  

3.5.3.  Male Victim Kits 
 

3.5.3.1. The penile, scrotal, oral, peri-oral, anal, and peri-anal (if present in the kit) will be sampled for 
differential extraction. 

 
3.5.3.2. The right and left breast/pectoral swabs (if present in the kit) will be sampled for non-

differential extraction with DTT. 
 
3.5.3.3. No alternate swabs will be selected if any of the swabs listed in 3.5.3.1 and 3.5.3.2 are not 

present in the SAFE kit, unless they meet the criteria for testing as outlined in Section 3.5.5.1. 
 

3.5.4. Female Victim Kits 
  

3.5.4.1. The cervical, vaginal, external genital, oral, peri-oral, anal, and peri-anal swabs (if present in the kit) 
will be sampled for differential extraction. 
 

3.5.4.2. The mons pubis, right breast, and left breast swabs (if present in the kit) will be sampled for non-
differential extraction with DTT. 

 
3.5.4.3. No alternate swabs will be selected if any of the swabs listed in 3.5.4.1 and 3.5.4.2 are not 

present in the SAFE kit, unless they meet the criteria for testing as outlined in 3.5.5.1. 
 

3.5.5. In addition to the swabs listed in 3.5.3 or 3.5.4, medical report-based sampling will be used as 
follows: 
  

3.5.5.1. If the medical report specifically indicates external ejaculation on an alternate body area (e.g., 
stomach), then the swab from that area will also be sampled for differential extraction. 
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3.5.5.2. If the medical report indicates a condom was worn, sampling of the SAFE kit will proceed 
based on 3.5.3 or 3.5.4. Condoms will be analyzed pursuant to separate requests 
submitted/accepted by the laboratory. 

 
3.5.5.3. Any initial medical report-based sampling of evidence outside of the above policies requires 

supervisor approval. 
  

3.5.6.  Investigators will be informed via the DNA report if untested samples are present in the SAFE kit that 
can be analyzed. Any subsequent analysis performed on these samples will be based on the submission 
of additional requests to the laboratory. 
  

3.5.7. Testing of SAFE kit samples will be done in accordance with the discontinuation of analysis policies. 
 

  
3.6. FACILITIES AND EVIDENCE CONTROL: See the laboratory’s Quality Manual for lab-wide policies 

regarding facilities and evidence control. The following are additional unit policies: 
   

3.6.1. Separate areas are designated within the Unit for evidence evaluation and DNA extraction, PCR 
setup, and for the amplification and analysis of amplified DNA. Procedures will be performed in 
the appropriate area for that analysis. 

  
3.6.2. Pipettes used in post-amplification processes must not be used in the pre-amplification areas 

without thorough decontamination and cleaning. 
  
3.6.3. The door of the room containing amplified DNA will remain closed except for passage. 
 
3.6.4. Amplified DNA will only be stored in the refrigerators and freezers in the post-amplification area.  
 
3.6.5. No reagents used in the post amplification processes will be stored in any refrigerator or freezer in 

the pre-amplification areas. 
 
3.6.6. Evidence and reagents should be stored separately in their designated locations while in the 

Forensic Biology Unit. 
 
3.6.7. Records will be maintained in the Reagent Preparation Log for any reagent prepared for casework 

application. The record will indicate the preparer, the date of preparation, and the lot numbers, or 
date of preparation, of components used in the preparation of the new reagent. 

 
3.6.8. Any visitors to the lab areas within Forensic Biology will be required to wear a mask and gloves 

during their time spent in pre-amplification lab areas. Visitors to lab areas will be asked to provide a 
sample for the elimination database. 

 
3.6.9. Analysts must wear appropriate personal protective equipment when examining evidence. This 

includes, at a minimum, a lab coat and gloves. Facemasks are recommended. 
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3.6.10. Prior to analysis, work areas must be cleaned with a 10-20% bleach solution. The work area will be 
covered with clean paper or bench mats prior to evidence analysis.  The contents of items must be 
inventoried and examined on a fresh piece of paper.  This paper can be used to wrap the item after 
examination. 

 
3.6.11. After analysis, items will be returned to the original packaging. The package must be sealed with 

evidence tape and the analyst must initial and date the seal.  The barcode number must be on the 
outer packaging. If the item cannot be returned to the original packaging, new packaging can be 
created, but the original packaging must be packaged with the item. 

 
3.6.12. Analysts must avoid compromising any information written on the evidence packaging.  Notation 

will be made in the case notes if the contents of the packaging could not be accessed without 
breaking an existing evidence seal. 

 
3.6.13. Evidence collected from the suspect(s) must not be sampled or extracted at the same time as 

evidence collected from the victim.  Case scenario information relating to the locations evidence 
items were collected must be considered so that evidence collected from locations associated with 
the victim are not extracted with evidence from locations associated with the suspect. The DNA 
extraction of evidence and reference samples must be separated by time and/or place. 

 
3.6.14. Hair evidence must be photographed if consuming more than half the length of a hair for DNA 

analysis. Close-up (i.e., macro-lens photography) is recommended. 
 

3.6.15. The creation of microscope slides is mandatory for sexual assault evidence suspected of containing 
semen any time a sample/stain will be consumed for DNA testing. 

 
3.6.16. Slides prepared will be dispositioned either with extracted DNA work product, or added to the 

packaging (e.g., SAFE kit) from which the microscopically examined item originally came from. 
 
3.6.17. Derivative evidence generated as a result of analysis will be assigned a new barcode in File-on-Q 

system, a notation as to final disposition will be made in the notes and report.  
 
3.6.18. If an evidence item is swabbed for DNA analysis, a notation will be made within the File-on-Q 

evidence tracking database regarding any additional associated barcodes created. 
 
3.6.19. Scissors used for sampling evidence must be cleaned thoroughly with bleach, soap and water, 

alcohol, or by flaming between sampling different stains.  Alternatively, a fresh scalpel blade will be 
used for each evidence sample. 

 
3.6.20. For any procedure performed in the Forensic Biology Unit only one tube or evidence item should 

be open at a time during any sampling and reagent/DNA addition.  Use of any robotics system for 
sample setup is an exception to this policy. 

 
3.6.21. All reagents and solutions will be autoclaved where possible.  Sterile water and sterile plastics or 

glassware will be used for solutions that cannot be autoclaved. 
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3.6.22. Reagents will be stored as small aliquots to minimize the effects of any contamination events. The 
lot(s) of reagents used for each set of analyses will be recorded.  

  
3.6.23. Sterile disposable aerosol resistant pipette tips and sterile tubes will be used for any processes 

involved in DNA analysis.  Pipette tips will be changed between adding or removing liquid from 
evidence sample tubes. 

  
3.6.24. The DNA extraction/purification of questioned samples will be performed separately from the 

DNA extraction/purification of reference samples.  In addition, it is advisable that DNA 
extraction/purification of samples, where high amounts of DNA are expected, (references or large 
bloodstains) be performed separately from samples where low amounts of DNA are expected 
(single hairs or very small stains) to minimize the potential for sample to sample contamination. 

 
3.6.25. At least one reagent blank will be employed for each set of DNA extractions/purifications to check 

for possible contamination of the DNA extraction reagents.  It is advisable to employ multiple 
reagent blanks in a batch extraction to accommodate the combining of samples, or the use of 
multiple DNA testing kits if any samples are consumed during a first analysis. 

 
3.6.26. A reagent blank will be subjected to all of the reagents and manipulations of the DNA analysis 

process as evidence samples.  
 

3.6.26.1. Reagent blanks will receive the same volume of reagents as the highest volume used for 
evidence samples. 
 

3.6.26.2. Reagents blanks will undergo the same manipulations as the most manipulated evidence 
sample associated with it. 

 
3.6.26.3. At least one reagent blank will be carried through amplification and analysis with its associated 

samples. 
 

3.6.26.3.1. Any reagent blank that has DNA detected at quantification will be amplified and 
analyzed. 
 

3.6.26.3.2. If multiple reagents blanks are associated with an extraction set and one has DNA 
detected in it, if no other amplification kit is likely to be used, then at least two 
reagent blanks should be amplified (i.e., the one with DNA detected and one 
without DNA detected) in an attempt to identify the detected DNA as an isolated 
event. 

  
3.6.26.4. Reagent blanks do not require microscopic examination, nor have any volume spotted onto a 

microscope slide when associated samples are being examined microscopically. 
 
3.6.27. When performing manual PCR setup, DNA must be added to the tubes after all reagents have been 

added. This practice reduces the possibility of inadvertent transfer of DNA between samples and kit 
reagents.   
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3.6.28. Only one sample tube will be open at a time during DNA addition in manual PCR setups. 
 
3.6.29. Only disposable lab coats are to be used in the post-amplification area. Always remove gloves and 

lab coats before exiting the post-amplification area. 
 
3.6.30. All surfaces in the Amplification Area should be cleaned with 10-20% bleach solution before and 

after setting up samples for analysis. 
 
3.6.31. All equipment found in the Amplification Area is dedicated to that area and will never be removed 

unless proper decontamination procedures have been employed. 
 
3.6.32. DNA interpretations must be documented in the technical record. 
 
3.6.33. CODIS sheets for evidence samples must be part of the technical record. 

 
 

3.7. DNA SAMPLE STORAGE 
 
3.7.1. Short term storage of extracted DNA will be the dedicated freezer in the PCR setup area.  DNA 

extracts should be stored in closed containers or sealed bags. 
  

3.7.2. Long-term storage of extracted DNA will be in the Property Room.  A new barcode number must 
be created for extracted DNA samples.  All new items in File-on-Q require an incident number to 
be assigned.  Any new incident number assigned to extracted DNA samples will follow the format 
of: “ExtDNAanalystthreeletterinitialsMMDDYY”.  
 

3.7.3. Storage of Amplified DNA samples will be in the dedicated freezer in the Amplification Area.  
Under no circumstances will amplified DNA be stored outside the Amplification Area. 
  
3.7.3.1. Amplified DNA samples will be maintained for a period of six months from the date of 

amplification.  After this time, the amplified DNA will be discarded. 
 
 

3.8. POLICIES REGARDING FREEZER PACKETS 
 
3.8.1. Freezer packets will be created to store derivative evidence separated or prepared from other 

evidence that is customarily stored unfrozen. 
  

3.8.2.  Freezer packets will be marked with the incident or case number and the barcode(s) of the evidence 
contained within. 

 
3.8.3. Any derivative evidence (stains, cuttings, or swabs) that will be impounded into the Property Room as 

additional evidence will require the generation of a new item in Evidence-on-Q under the appropriate 
incident number. 
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3.8.4.   Documentation of the newly generated items should be included in the case notes and report. 
 

 
3.9. UNIQUE IDENTIFIERS 

 
3.9.1. The barcode number will uniquely identify each item stored in the Property Room or Laboratory 

Vault under the File-on-Q system. 
 

3.9.2. Items stored under the old system will be uniquely identified by the case number (or lab sequence 
number), property tag number, and item number. 

 
3.9.3. Multiple items contained within a single package (e.g., the contents of a SAFE kit) will all be given a 

sub-item designations, which will be noted in the barcode system for that item. 
 

3.9.4. Any stains, cuttings, or swabs (i.e., derivative evidence) taken from items must be able to be tracked 
back to the location from which they were sampled. 

 
3.9.5. Derivative evidence that will be impounded into the Property Room will require the generation of a 

new item in the barcode system under the appropriate incident number. This new barcode will 
uniquely identify these pieces of derivative evidence. 

 
3.9.6. All items included on a laboratory request to be examined by the laboratory (excluding internally 

produced requests) are considered evidence. 

 
3.9.7. All cell pellets, extracted DNA, and amplified DNA will be considered the work product of the DNA 

laboratory. 
 

3.9.8. Each sample analyzed within a batch will be labeled with an identifier that will uniquely identify it 
during its analysis. Additional descriptors may be employed to identify particular samples, such as 
“NS” to identify non-sperm fractions of extracts.   

 
   
3.10. DISCONTINUING ANALYSIS OF SAMPLES 

  
3.10.1. Variables, such as the existence of other probative samples, or the case scenario may affect the 

decision to discontinue the analysis of a sample.  
  
3.10.2. Quantification information provides information into the likelihood of obtaining interpretable DNA 

results, and the decision to discontinue analysis will be made after quantification of the sample(s). 
 
3.10.3. If a sample contains insufficient DNA to reasonably obtain an interpretable DNA profile, it will be 

discontinued. 
 

3.10.3.1. If 8μL of a sample are quantified AND the amount of total DNA in the extract is less 
than or equal to ≤0.0005ng/μL, and all controls indicate the quantification has 

Not 
for

 La
bo

rat
ory

 U
se



Unit Policy Manual 
Forensic Biology 

Forensic Biology Unit Policy Manual v07-09-2020  Page 31 of 86 

performed as expected, the samples are unlikely to yield interpretable DNA results with 
the GlobalFiler amplification kit and the sample will be discontinued. 

  
3.10.3.1.1. Analysts will consult with the DNA Technical Manager if they believe the control 

results cause them to doubt the reliability of the data from the quantification assay. 
  
3.10.3.1.2. Documented permission from the DNA Technical Manager is required to amplify 

samples for which quantification values <0.0005ng/μL are obtained. 
 

3.10.3.2. Samples that are expected to have a low amount of DNA and all sperm fractions will 
have 8μL of extract quantified. 

  
3.10.4. In cases where multiple samples from the same item are collected for the same purpose (e.g., DNA 

sample collected from two different areas on a shirt for wearer information), if one sample has 
sufficient DNA additional samples collected for the same purpose may be discontinued. 
  

3.10.5. For sexual assault cases: 
 

3.10.5.1. For multiple perpetrator, loss of awareness (as specified in medical report), mental 
disability (specified in request), a victim under the age of 14, or single perpetrator cases 
with consensual sexual activity within 5 days, all samples with male DNA above the 
discontinuation threshold (>0.0005ng/μL) and below the human:male ratio of 75:1 
will be amplified. 

 
For differentially extracted samples: 

  
3.10.5.1.1. If the sperm fraction is relevant and being typed, the associated non-sperm fraction 

can be discontinued.   
 

3.10.5.1.2. If the non-sperm fraction is investigatively relevant and being typed and the sperm 
fraction has >0.0005ng/μL male DNA detected, both the sperm and non-sperm 
fractions must be DNA typed. 

 
3.10.5.1.3. If the non-sperm fraction is investigatively relevant and the sperm-fraction has 

insufficient male DNA detected, only the non-sperm fraction will be DNA typed.    
 

3.10.5.2. For a single perpetrator scenario with no consensual sexual activity within 5 days, only 
one sample from each body location tested (i.e., vaginal cavity, anal cavity, oral cavity, 
and external body surface) with male DNA above the discontinuation threshold 
(>0.0005ng/μL) and below the human:male ratio of 75:1 will be amplified. 
  

3.10.5.2.1. If the sperm fraction is investigatively relevant and being typed, the associated 
non-sperm fraction can be discontinued.   
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3.10.5.2.2. If the non-sperm fraction is investigatively relevant and being typed and the sperm 
fraction has >0.0005ng/μL male DNA detected, both the sperm and non-sperm 
fractions must be DNA typed. 

 
3.10.5.2.3. If the non-sperm fraction is investigatively relevant and the sperm-fraction has 

insufficient male DNA detected, only the non-sperm fraction will be DNA typed.    
 

3.10.5.3. If insufficient male DNA is detected in the sperm fraction and the non-sperm fraction 
has no male DNA, or a human:male DNA ratio greater than 75:1, the analysis of both 
fractions will be discontinued.  
  

3.10.5.3.1. If all tested samples meet the requirements for discontinuation, but male DNA 
was detected, the analyst will seek and document supervisor permission to 
attempt to combine the single sample with the highest amount of male DNA with 
the remaining evidence in an attempt to obtain an interpretable DNA profile. If 
permission is obtained, testing of the remaining swab will proceed based on the 
laboratory consumption of evidence policy.  
  

3.10.5.3.2. In the situation where male DNA is detected but the human:male ratio is greater 
than 75:1, YSTR testing may be considered if a suspect reference sample is 
available and no other fractions in the case are being typed. 

  
3.10.5.3.3. When Y-STR analysis is possible, but not performed (because no suspect reference 

is available), the report will indicate that Y-STR testing can be performed upon 
request. 

 
3.11. USING EXTERNALLY-DERIVED DATA FOR LIKELIHOOD RATIO COMPARISONS 

  
3.11.1. For the purpose of the policies in section 3.11, externally-derived data refers to reference DNA 

profiles, single source evidence profiles, or complete genotypes from partial DNA profiles 
generated in other accredited (e.g., ANAB or A2LA) DNA laboratories. 
  

3.11.2. Externally-derived data must have been interpreted by the other laboratory in order to be used for 
comparisons. 
   

3.11.3. The externally-derived data that will be used in comparisons is only that which represents complete 
genotypes at any locus. 

 
3.11.4. The policies in 3.11 also apply to “goodness-of-fit” comparisons for CODIS hits. 

 
 

4 .  CODIS 
 
The Combined DNA Index System (CODIS) is a nationwide forensic DNA database managed by the FBI.  It consists 
of DNA databases at the local (LDIS), state (SDIS), and national (NDIS) levels.  The purpose of CODIS is to develop 
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investigative leads by matching DNA profiles of two or more samples from these various categories. The database 
primarily consists of casework evidence profiles and convicted offender profiles.  Sample categories include Forensic 
Unknowns (single source profiles), Forensic Partials (single source, but partial profiles), Forensic Mixtures, 
Convicted Offenders, Arrestees, Suspects, Unidentified Human Remains, Missing Persons, and Relatives of Missing 
Persons.   
 

4.1. SDPD CODIS OPERATIONS 
  
4.1.1. If the CODIS Administrator determines at any point that the CODIS network, software, or data has 

been compromised, the DNA Technical Manager will be immediately notified.   
  

4.1.2. The DNA Technical Manager and CODIS Administrator will determine the proper course of action to 
reinitiate participation in CODIS for the analyst(s) or laboratory. 

  
4.2. ENTRY OF DNA PROFILES INTO CODIS 

  
4.2.1. The SDPD Forensic Biology Unit’s procedures for the entry of DNA profiles into CODIS will be 

based upon the guidelines outlined in the NDIS Procedures and the California Penal Code. 
  
4.2.2. DNA profiles selected for entry into CODIS will be documented in the technical record on 

worksheets referred to as CODIS sheets. If multiple items from the same case have the same DNA 
profile, only one CODIS sheet should be used. 

 
4.2.3. Any consultations with the CODIS Administrator that affect or alter a potential CODIS search will 

be documented in the technical record. 
 
4.2.4. CODIS sheets must be technically reviewed to ensure accuracy of the DNA types and specimen 

category, and acceptability for CODIS entry. 
 
4.2.5. Any material changes made to the CODIS entry as a result of technical review must be documented. 
 
4.2.6. Any material changes made by the CODIS Administrator after technical review is complete must be 

discussed with case analyst and documented within the analytical record. 
 
4.2.7. Forensic mixture and forensic partial DNA records submitted to NDIS will be reviewed to ensure 

the DNA records satisfy a statistical threshold for match rarity of approximately one in the size of the 
NDIS database. 

 
4.2.8. DNA profiles (single source or mixtures) from possible perpetrators derived from evidence should 

be entered into CODIS, unless that evidence was collected from a suspect. 
 
4.2.9. DNA profiles derived from firearms in felon in possession cases are not eligible to be searched in 

CODIS. 
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4.2.10. DNA profiles or portions of DNA mixtures attributable solely to victims or elimination reference 
samples (boyfriend, husband, etc.) will not be entered into CODIS.   

 
4.2.11. Forensic profiles in CODIS that are ultimately linked to consensual partners will be removed from 

the database. 
  
4.2.12. CODIS sheets will be filled out for qualifying suspect samples (see section 4.1) that were not 

matched to an evidence sample or that were included as possible contributors to a DNA mixture.   
 
4.2.13. In general, CODIS sheets will be removed from the case file during the administrative review and 

given to the CODIS Administrator for entry.  Copies of CODIS sheets must be retained within the 
technical record as numbered pages to document the CODIS search. 

  
4.2.14. CODIS profiles will be reviewed for eligibility, correct DNA types, and appropriate specimen 

category prior to upload to local CODIS or beyond. This policy is not meant to prevent a keyboard 
search of DNA profiles in the local CODIS database. 

 
4.2.15. For any profile uploaded into the CODIS databases, the level of CODIS searched will be disclosed in 

the report per ANAB and Quality Manual requirements. If a profile that is searchable per NDIS or 
State policies is not searched (e.g., due to similarity with another profile being searched), the reason 
for not searching the profile must be documented in the technical record.  
         

 
4.3. UPLOADING SUSPECT DNA PROFILES 

  
4.3.1. DNA profiles from adult suspect samples analyzed by the SDPD laboratory will be uploaded to the 

local CODIS database if one of the following conditions have been met. 
  

4.3.1.1. They have been arrested for a felony,  
  

4.3.1.2. They are subject to conditions associated with fourth waiver status,  
 

4.3.1.3. They are mandated by a court order to provide a DNA sample, or  
 

4.3.1.4. They have provided consent to the collection of their DNA by signing a SDPD Consent Form 
acknowledging their DNA profile will be entered into the local CODIS database. 

  
4.3.2. Suspect DNA profiles will be maintained indefinitely within the local CODIS database.  

  
4.3.3. DNA profiles previously uploaded to the State CODIS database will be removed from the State level 

of CODIS and remain at the local level after the profile has been in State CODIS for a period of two 
years. 

 
4.3.4. Should a suspect with their profile entered into the State CODIS Database be eliminated as a suspect 

in the case for which their sample was submitted, the DNA profile from that individual will be 
removed from the State CODIS Database. 
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4.3.5. No DNA profiles obtained from juveniles (i.e., under the age of 18 at the time of collection) will be 

stored in the local CODIS database. 
 

 
4.4. DATABASE SEARCHES AND MATCHES 

  
4.4.1. Searches of the SDPD’s local DNA database can occur prior to technical review and are also 

performed at the time of the entry of the profile into CODIS.  
  

4.4.2. Newly generated DNA profiles for searching will be uploaded to the state database at least once a 
week to coincide with database searches and with the uploading of DNA profiles from state to 
national databases. 
  

4.4.3. Information contained within the SDPD’s local DNA database (SDPD’s LDIS) may be shared with 
accredited forensic DNA laboratories in other jurisdictions. Similarly, information from the LDIS of 
accredited laboratories from other jurisdictions may periodically be shared with our laboratory.   

 
4.4.3.1. A “batch file” containing the information within LDIS will be provided for the purpose of 

comparing DNA profile information between jurisdictions.   
  

4.4.3.2. When the SDPD Crime Laboratory receives a batch file from another agency, the batch file 
will be used for a search against LDIS.   

 
4.4.3.3. DNA data from the external agency will not be stored with the SDPD’s LDIS and ownership of 

the data will retained by the agency from which it originated.   
 

4.4.3.4. It will be communicated to outside agencies receiving batch files of DNA database data 
information from the SDPD LDIS that they must not store SDPD DNA data in their LDIS.  

 
4.4.4. Dispositioning of potential hits within CODIS will be performed by the CODIS Administrator, or 

designee, in accordance with NDIS procedures. 
 

4.4.5. Potential hits at any level of CODIS will be evaluated for “goodness of fit”.  If the potential match is 
deemed to be good, the notification process will be allowed to proceed. “Goodness of fit” of any 
potential database match will be dependent on the specimen category. 

 
4.4.5.1. Potential matches between forensic unknowns and any sample in a single source sample 

index (e.g., convicted offender) can be assessed visually.  
  

4.4.5.2. Potential matches between a mixture or partial DNA profile and any sample in a single 
source sample index will be assessed through calculation of a likelihood ratio.  
 
Note: The likelihood ratio will assess the probability of the evidence given the DNA profile 
from the putative match is a component of the mixed or partial DNA profile searched against 

Not 
for

 La
bo

rat
ory

 U
se



Unit Policy Manual 
Forensic Biology 

Forensic Biology Unit Policy Manual v07-09-2020  Page 36 of 86 

the probability of the evidence given the DNA profile from the putative match is not in the 
mixed or partial DNA profile searched. 
 

4.4.5.3. If a potential match is between a profile in the local suspect category and either a mixture, or 
partial DNA profile, the local suspect profile must have the full complement of data for the 
likelihood ratio comparison being reported (i.e., if the local suspect only has data at 15 loci, 
the reference sample must be tested for the full GlobalFiler dataset). 
 

4.4.5.4. In general, the likelihood ratio results used for the assessment will be the lowest 99% 1-
sided HPD value for the four population groups. 
 

4.4.5.4.1. Potential associations to the database with likelihood ratio results greater than fifty times 
the size of the relevant database in these comparisons will be declared as offender or 
forensic hits. 

  
4.4.5.4.2. For comparisons with the local database, potential associations with likelihood ratio 

values less than the size of the local database will be disregarded. 
 
4.4.5.4.3. Potential associations with State and National databases will be evaluated by the CODIS 

Administrator, or designee. Additional data may be requested from the jurisdiction with 
which the putative hit has occurred to further evaluate its validity. 

  
4.4.5.4.4. Likelihood ratio results between one and fifty times the size of the local database will be 

further reviewed to determine if the putative associations will be reported.  
 
4.4.5.4.5. Likelihood ratio results used to assess forensic and offender hits will be retained in the 

case record, or electronically (G:\Misc DATA\CODIS\CODIS Matches).  
 
4.4.5.4.6. If the database LR results are sufficiently high (e.g., 1.0x1011 or greater), it may not be 

necessary to perform an LR with HPD calculation as the value considering the HPD is 
unlikely to be less than the likelihood ratio threshold. 
 

4.4.6. Information regarding forensic and offender hits must be included in at least one report. Prior to a 
match report being written, investigators may be contacted regarding DNA matches.  Information 
must be communicated accurately. The communication of a database hit must be documented in a 
communication log. Prior to releasing database hit information to an investigator, the results must be 
reviewed by a second analyst and the review documented in the notes. 

 
4.4.7. When likelihood ratios are calculated comparing any suspect profile from the local CODIS database 

to any mixture or a partial evidence profiles, the suspect profile must have all the loci contained in the 
evidence sample. This requirement applies even if the suspect reference was associated to a Forensic 
Unknown (i.e., single source) component of a mixture. 

 
 

4.5. MAINTENANCE OF AN ELIMINATION DATABASE IN CODIS 
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Section 3.0 in the Quality Manual addresses this database. The following are the policies for the collection and 
analysis of these samples: 

 
4.5.1. The Quality Manager will coordinate sample collection of reference mouth swabs from the donors and 

coding of the sample. 
 

4.5.2. Mouth swab samples from donors to the elimination database will only be retained with permission 
from the donor. 

 
4.5.3. Elimination database samples will be analyzed by a qualified DNA analyst following the protocol used 

to analyze reference mouth swabs in casework. 
 

4.5.4. The DNA Technical Manager or CODIS Manager will review the analysis prior to entering the DNA 
profiles in any databases used for comparisons to evidence. 

 
4.5.5. Electropherograms will be maintained for each sample. 

 
 

4.6. REPORTING DNA RESULTS ASSOCIATED TO THE ELIMINATION DATABASE. 
  
4.6.1. When an evidence DNA profile is found to match or potentially be associated with a profile in the 

elimination DNA database, the following will be done: 
  

4.6.1.1. The CODIS match detail report, or first page of the STRmix Database Search report indicating 
the association will be included in the analytical record. 
  

4.6.1.2. If the DNA profile in the case was found to match (or the mixture potentially includes) DNA 
from any elimination profile at an HPD LR value above 2 (i.e., limited support for inclusion or 
above), a Quality Incident Summary form will be completed detailing the association. 

 
4.6.1.3. The Quality Incident Summary form will be submitted to the DNA Technical Manager, or 

designee. Any associations with HPD values above 10,000 will be routed through the Quality 
Manager. 

 
4.6.1.4. Associations to the elimination database when the HPD LR is greater than 99 will be reflected 

in the report. 
  

4.6.1.4.1. If the HPD LR value is greater than moderate support for inclusion (i.e., LR>104), the 
analyst will condition the evidence profile on the elimination sample, unless the 
elimination sample represents the sole unattributed contributor in the evidence sample.  
  

4.6.1.4.2. The report will list the elimination sample as an assumed contributor if the profile is 
used as a conditioning profile, otherwise the LR and associated verbal scale descriptor 
will be reported. 
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4.6.1.4.3. If the LR value is in the moderate support for inclusion (i.e., 102<LR<104), the report 
will list the elimination sample as having moderate support for inclusion. 
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4.7. OUTSOURCING 
 

In order for the SDPD Crime Laboratory to accept outsourced data for the purposes of searching the CODIS 
databases the following criteria must be met prior to the initiation of analysis by the vendor laboratory: 

 

 The vendor laboratory selected for the analytical testing must be accredited and the documentation of that 
accreditation, including the vendor laboratory’s latest external audit report including responses and follow-
up must be provided to the SDPD Crime Laboratory. 

 Prior approval by the DNA Technical Manager of the technical specifications of any DNA analysis to be 
performed by the vendor laboratory is required. 

 An on-site visit to the vendor laboratory is required. 
 

4.7.1. OWNERSHIP OF OUTSOURCED DATA 
  

4.7.1.1. SDPD ownership of outsourced data occurs when: 
 

4.7.1.1.1. The SDPD will use any samples, extracts, or materials from the vendor laboratory 
for the purposes of forensic testing (i.e., a vendor laboratory prepares an extract that 
will be analyzed by the SDPD laboratory);  

4.7.1.1.2. The SDPD will interpret the data generated by the vendor laboratory;  
4.7.1.1.3. The SDPD laboratory will issue a report on the results of the analysis; or  
4.7.1.1.4. The SDPD will enter or search a DNA profile in CODIS from data generated by the 

vendor laboratory. 
  

4.7.1.2. The SDPD will not take ownership of any cases deemed “negative”. Negative cases are those that: 
  

4.7.1.2.1. Are negative during initial screening; 
4.7.1.2.2. Are determined to have quantities of DNA unsuitable for autosomal STR analysis; or 
4.7.1.2.3. Yield DNA profiles consistent with originating from the reasonably expected donor 

of the item, consensual partners, or witnesses. 
  

4.7.2. ON-SITE VISITS TO VENDOR LABORATORIES 
 

4.7.2.1. Prior to the initiation of testing in an outsourcing agreement, an on-site visit of the vendor 
laboratory must be documented. 
 
4.7.2.1.1. The on-site visit of the vendor laboratory must be conducted by the DNA Technical 

Manager, or another qualified (or previously qualified) analyst designated by the DNA 
Technical Manager, or Supervising Criminalist. 

4.7.2.1.2. An on-site visit performed by the technical leader, or designated employee of an NDIS 
laboratory that uses the same technology, platform, and typing amplification test kit 
may be accepted by the DNA Technical Manager in lieu of performing the on-site visit 
outlined in 4.5.2.1.1. 

 
4.7.2.2. An on-site visit to a vendor laboratory will include at a minimum: 

Not 
for

 La
bo

rat
ory

 U
se



Unit Policy Manual 
Forensic Biology 

Forensic Biology Unit Policy Manual v07-09-2020  Page 40 of 86 

 
4.7.2.2.1. An evaluation of the laboratory facilities to ensure the integrity of the evidence will be 

maintained while in the custody of the vendor lab. 
4.7.2.2.2. An evaluation of the procedures as they relate to ensuring minimal loss or 

contamination of the evidence while in the custody of the vendor lab. 
4.7.2.2.3. An evaluation of any Corrective Actions taken by the laboratory in the previous six 

months prior to the on-site visit. 
4.7.2.2.4. An interview with the vendor laboratory’s DNA Technical Manager or laboratory 

analyst. 
  

4.7.2.3.  The on-site visit will be documented and maintained by the DNA Technical Manager. 
  

4.7.2.4. If an outsourcing agreement with a vendor lab is extended beyond one year, annual on-site visits to 
the vendor laboratory must be documented. 
 
4.7.2.4.1. As described in 4.5.2.1.2, an on-site visit conducted by another NDIS participating 

laboratory, or FBI designated employee may be accepted by the DNA Technical 
Manager. 

 
4.7.3. QUALITY CONTROL OF OUTSOURCING DATA 

  
4.7.3.1. Complete technical review will be conducted on approximately 3% of “negative cases” as defined in 

4.5.1.2. 
 

4.7.3.2. The SDPD Laboratory will conduct retesting on approximately 3% of all outsourced cases to 
ensure the accuracy of the testing results reported by the vendor laboratory. If a case selected for 
retesting had a searchable DNA profile obtained, but retesting would require the consumption of 
the original evidence, then a new case will be selected for retesting so as not to consume the 
original evidence. It is permissible to consume original evidence for any negative cases selected for 
retesting.   

  
4.7.4. OUTSOURCED DATA 

  
4.7.4.1. A technical review of the outsourced data will be performed prior to uploading any DNA profiles 

to SDIS (or NDIS). 
  

4.7.4.2. The technical review of the outsourced data will be performed by an analyst: 
 

4.7.4.2.1. That is, or was previously, qualified in the technology, platform, and typing 
amplification kit used to generate the data; 

4.7.4.2.2. That participates in the SDPD external proficiency test program to the full extent they 
participate in casework and the review of outsourced data; 

 
4.7.4.3. The technical review of the outsourced data will include a review of: 

  
4.7.4.3.1. All DNA types to verify that they are supported by the raw and/or analyzed data; 
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4.7.4.3.2. All associated controls, internal lane standard and allelic ladders to verify the expected 
results were obtained; 

4.7.4.3.3. The final report to verify the results and conclusions are supported by the data, and that 
each item tested has been addressed. 

4.7.4.3.4. The DNA types, eligibility, and correct specimen category of any profile to be uploaded 
into CODIS. 

  
4.7.4.4. A notification will be issued by the Forensic Biology Unit for any outsourced case in which a DNA 

profile is being searched in CODIS. The report will indicate the extent of the database search (i.e., 
local, State, or National). 

 
 

4.8. REINTERPRETATION OF LEGACY AMPLIFICATION KIT DATA 

According to the FBI Director’s Quality Assurance Standards for DNA Testing Laboratories standard 13 states, an 
analyst can only interpret data generated by the amplification test kit in which he or she is currently proficiency 
tested, therefore if the analyst is not currently proficiency tested in an amplification test kit previously used by 
the laboratory (i.e., a legacy amplification kit), the analyst cannot reinterpret the legacy data.  

This policy is intended for situations when an analyst is required to reinterpret data generated with legacy 
amplification test kits for a comparison made to DNA profiles generated with amplification test kits in current 
use. 

Reinterpretation of legacy data may occur in accordance with the following: 

1. If an analyst is currently qualified in an amplification test kit (trained and proficiency tested), and the 
analyst was previously qualified (trained and proficiency tested) in the legacy amplification test kit, 
the analyst can reinterpret the legacy data if the analyst has been proficiency tested on the legacy test 
kit within the last two calendar years. If an analyst has not been proficiency tested on a legacy test kit 
within the last two calendar years, then the Technical Leader must document and approve the 
completion of the analyst’s review of the validation data and standard operating procedures of the 
legacy test kit. If an analyst, who has completed the requirements to interpret legacy amplification 
test kit data, has not reviewed the required documents within the last two calendar years, the 
Technical Leader must document and approve the completion of the analyst’s additional review. 

 
2. If an analyst is currently qualified in an amplification test kit (trained and proficiency tested), but has 

never been previously qualified in the legacy amplification test kit, the analyst can reinterpret the 
legacy amplification test kit data if the analyst is trained in the legacy test kit interpretation protocols 
by a previously qualified analyst. The review of the validation data and standard operating procedures 
of the legacy test kit, training by the previously qualified analyst, and interpretation competency test 
must be completed by the analyst, and documented and approved by the Technical Leader. 
Documentation shall contain sufficient information for an auditor to confirm the analyst is qualified to 
reinterpret legacy amplification test kit data.  
 

3. If a previously qualified analyst is unavailable to train a currently qualified analyst on a legacy 
amplification test kit, it is highly recommended that the current analyst not reinterpret legacy data. 
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However, if the current analyst must perform legacy interpretation without training from a 
previously qualified analyst, then it is recommended that the currently qualified analyst and Technical 
Leader train in the legacy test kit interpretation protocols, review validation data and standard 
operating procedures. The training and interpretation competency test must be completed by the 
analyst, and documented and approved by the Technical Leader. Documentation shall contain 
sufficient information for an auditor to confirm the analyst is qualified to reinterpret legacy 
amplification test kit data. 

 
4. If a laboratory generates new interpretation protocols from legacy validation data (e.g., developing a 

stochastic threshold when none previously existed), the laboratory shall document the basis for the 
new interpretation protocols. These new protocols shall be documented in the laboratory’s standard 
operating procedures and memorialized in the Quality Assurance Standards Audit Document. The 
training and interpretation competency test must also be completed by the analyst, and documented 
and approved by the Technical Leader. Documentation shall contain sufficient information for an 
auditor to confirm the analyst is qualified to reinterpret legacy amplification test kit data.  

Technical reviewers of reinterpretations of the legacy data are held to the same training requirements as the 
analyst reinterpreting the data. 

5 .  LABORATORY MAINTENANCE 
 

5.1. GENERAL LABORATORY MAINTENANCE 
 
All members of the Forensic Biology Unit are responsible for the general upkeep of the laboratory including 
stocking supplies, and cleaning common areas.  Protective gloves and a laboratory coat should be worn when 
cleaning the laboratory or instruments. The following maintenance and cleaning policies are in addition to the 
cleaning required by analysts prior to and after using any bench area or instrument for analysis.   
 
WEEKLY DUTIES 
 

 Monitor the operating temperatures of all freezers, refrigerators, and incubators.  Log temperatures on the 
log sheets attached to instrumentation.  When a sheet has been completed, it should be scanned into the FB 
network and moved to the appropriate folder within the QA-QC folder.  The scanned sheet should be saved 
using a file name that clearly indicates what instrument the log is for and what time period it covers. 
  

 Fill distilled water carboys, reagent alcohol bottles, 10-20% bleach solution bottles, and Liquinox detergent 
bottles. 
  

 Wash glassware and dishes.  Return washed dishes to their appropriate storage location. 

5.1.1.  Glassware Washing 
 
Protective gloves and a lab coat or apron should be worn.   
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1. Wash glassware in warm water with Liquinox detergent and/or dilute bleach. Incubate for at least 15 
minutes. 
 

2. Rinse detergent from glassware thoroughly by rinsing in tap water. 
 

3. Rinse each piece of glassware in distilled water. 
 

4. Set glassware to dry. 
 

5. Return glassware to appropriate storage location when dry. 
 

MONTHLY DUTIES 
 
 Restock and organize supplies and workstations. 

 

 Wipe counters with 10-20% bleach solution. 
 

 Wipe/dust all instrument exteriors with ethanol. 
 

 Clean centrifuges with 10-20% bleach solution followed by distilled water. 
 

 Wipe inside of hoods with 10-20% bleach solution and plastic/exterior surfaces with ethanol. 
 

 Clean interior and exterior of drying boxes with 10-20% bleach solution. 
 

 Wipe/dust all shelving units. 
 

 Wash EZ1 strip and tip holders, QIAcube tip waste drawer inserts, and QIAsymphony sample and elution 
racks. 

 
 Vacuum floors (except post-amplification room floor). 

 
 Mop (or Swiffer) the floors using 10-20% bleach. 

 
 Clean sinks. 

 
Record the completion of cleaning tasks in the Monthly Cleaning Worksheets and submit them for scanning in 
the Maintenance Logs. 
 
5.2. MAINTENANCE LOGS 
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The following cleaning logs will be maintained by the Forensic Biology Unit.  They are intended to ensure 
laboratory areas are kept in a clean state.  Any cleaning should be entered electronically into the FB cleaning log 
excel workbook.  

 

Cleaning Logs Location Frequency 

Front extraction area with microscopes Electronic Monthly 

Main extraction/purification Electronic Monthly 

PCR Setup and Post-Amplification Electronic Monthly 

 
 

5.3. DISPOSAL OF HAZARDOUS WASTE 
 

There are six waste streams within the Forensic Biology Unit that should be handled as hazardous waste.  
These are as follows: 
 

5.3.1. PHENOLPHTHALIN CONTAMINATED SWABS 
Phenolphthalin contains ethanol and swabs contaminated with it will go into appropriately 
labeled waste buckets.  After the swabs have dried the swabs can be disposed of in the 
regular trash. 
 

5.3.2. PHENOLPHTHALIN AND LMG LIQUID WASTE  
Phenolphthalin and LMG liquid waste contains zinc; a heavy metal.  The unusable liquid 
waste will be stored in the Chemical Storeroom for disposal.  The bottles should be 
appropriately labeled with the hazard (flammable for pheno and corrosive for LMG).  The 
zinc contained in both reagents should also be noted on the log. 

 
5.3.3. QIAGEN REAGENT WASTE (EZ1 or QIAsymphony) 

EZ1 strips are flammable because of the ethanol they contain and should be placed in the 
designated waste containers by the instruments.  All tips, tip holders, and tubes can be 
disposed of as regular trash.  When the EZ1 strip waste containers are full the waste can be 
transferred to the Chemical Storeroom for disposal. Liquid QIAsymphony waste can also be 
transferred to the Chemical Storeroom. 

 
5.3.4. FORMAMIDE WASTE 

Formamide is a known teratogen and the formamide waste will be disposed of in the waste 
bucket in the amplification room.  When full the waste can be transferred to the Chemical 
Storeroom for disposal. 

 
5.3.5. BIOHAZARDOUS WASTE 

Large volumes of liquid blood are biohazardous.  Any large volumes of blood and the 
materials used to clean them up should be disposed of in red biohazard containers. 
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5.3.6. NON-HAZARDOUS WASTE 

Small volumes of blood that will dry within a reasonable amount of time can be disposed of in the 
regular trash.  LMG test swabs can be disposed of in the regular trash.  All plasticware (e.g., tips, 
tubes, transfer pipets, etc.) and gloves can be disposed of in the regular trash.  Acid phosphatase test 
swabs can be disposed of in the regular trash and any waste liquid down the drain. 
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6.  EQUIPMENT MAINTENANCE PROTOCOLS 
 

6.1. USE AND MAINTENANCE OF THE WATER SYSTEM 
 

The ultra/nano pure system uses the distilled water reservoir as its water source.   
 

Ultra pure water 
The Barnstead NANOpure ultra pure water system removes ions from water.  It is meant to be used with 
pretreated water.  Hence, the water used is first distilled.  The system can be set to three different modes: off, 
standby, and on.  The system is left on standby when not actively in use to allow water to be circulated 
through the cartridges for five minutes out of every hour.  This extends the life of the cartridges.  When ultra 
pure water is needed, set the system to the on mode by pressing the ‘ON/STANDBY/OFF’ button until a 
numerical value appears.  This number represents a resistivity measurement of the water, which indicates its 
purity.  Wait for the number to increase to at least 18.0 before dispensing.  If this number remains below 
18.0, then the cartridge is no longer efficiently deionizing the water.  A carboy is used to collect and store 
ultra pure water, as the system produces purified water rather slowly.  The ultra pure water system should 
never be used when the distilled water reservoir is empty.  A low water protection device has been built into 
the distilled water reservoir to prevent the ultra pure water system from operating when the still is low. 

 
 

6.2. OPERATION OF THE pH METER 
 

Thermo Scientific Orion Star A111 pH Meter Operation 
 
Electrode Preparation 
1. Disconnect electrode from meter. 
2. Uncover the filling hole and add electrode filling Ag/AgCl solution. 
3. Solution must be above reference junction and at least one inch above sample level. 
4. The filling hole must be open when electrode is in use and closed when in storage. 
5. Place the electrode in the electrode holder and suspend it in air for 5 minutes so that the solution in the 

electrode can thoroughly wet the reference junction. 
6. Shake electrode downward (similar to a thermometer) to remove air bubbles. 
7. Soak electrode in pH electrode storage solution for 30 to 60 minutes. 
8. Connect electrode to meter. 
 
Electrode Storage 
1. Short-term Storage (up to one week) 

a. Soak the electrode in pH electrode storage solution. 
b. To prevent crystallization of the fill solution, cover the fill hole whenever the electrode is being stored and 

open the fill hole when calibrating and measuring. 
2. Long-term Storage (more than one week) 

a. Fill the reference chamber and securely cover the filling hole. 
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b. Cover the sensing element and reference junction with the protective cap/sleeve containing a few drops 
of storage solution. 

c. Before returning the electrode to use, prepare it as a new electrode. 
 
Electrode Maintenance 
1. Inspect the electrode for scratches, cracks, salt crystals. 
2. Rinse off salt crystals with DI water. 
3. Drain the reference chamber, flush it with fresh filling solution and refill the chamber with fresh filling 

solution. 
 
Electrode Cleaning 
1. Soak electrode in 0.1 M HCL or HNO3 for 30 min. 

a. Can also be soaked in a 1:10 dilution of household bleach mixed with hot water (stir at fast rate). 
2. Drain the reference chamber and refill it with fresh filling solution. 
3. Soak the electrode in pH electrode storage solution for at least 1 hour. 
 
Calibration 
1. Prepare the electrode according to the electrode preparation instructions. 
2. Connect the probe to the meter and turn on the meter. 
3. Press mode to display pH for the pH measurement mode. 
4. Select 2 pH buffers that bracket the pH you are targeting. 
5. Press Cal 
6. Rinse the electrode in DI water and blot with a kim wipe. 
7. Place electrode into first buffer. 
8. Wait for “Ready” then record value in log book. 
9. Rinse the electrode in DI water and blot with a kim wipe. 
10. Place electrode into second buffer. 
11. Wait for “Ready” then record value in log book. 
12. Rinse the electrode in DI water and blot with a kim wipe. 
 
Measurement 
1. Perform Calibration steps first. 
2. Make sure it is in pH measurement mode. 
3. Press measure: the meter will immediately start taking readings. 
4. When “Ready” is displayed the meter stops measuring the pH, so you may need to press measure 

multiple times when pH-ing the solution. 
5. When you reach the target pH rinse the electrode in DI water and blot with a kim wipe.  
6. Turn pH meter off. 
Store electrode according to the Electrode Storage directions provided. 

 

6.3. OPERATION OF THE AUTOCLAVE 
 

The autoclave is used to sterilize critical reagents and equipment via steam pressurization.  There are two exhaust 
selector settings on the autoclave:  FAST (Instruments) and SLOW (Liquids).  Use the slow setting when only 
liquids or liquids and equipment are being sterilized.  If sterilizing equipment use the fast setting. 
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1. Close the drain valve. 
2. Fill with autoclave with approximately 5.5 liters distilled water and 0.5 liters tap water. 
3. Load autoclave with items to be sterilized.  Place autoclave tape on lids, if necessary, and be sure lids are on 

loosely. 
4. Close autoclave door.  Be sure the door closes tightly.  If not, adjust the screw below the door handle latch. 
5. Set the exhaust selector to “Fast or Slow”, depending on the items being sterilized. 
6. Set the time for 30 minutes. 
7. When the sterilization is complete, carefully open the door and drain valve.  Do not open the autoclave 

immediately after sterilization is complete due to the high heat and pressure; allow to cool and depressurize. 
 
 

6.4. BALANCES 
  

6.4.1. Laboratory balances will be calibrated and verified by an outside company once a year.   
 

6.5. MAINTENANCE OF THE QIAGEN EZ1s 
 

Each month the piercing units will be cleaned and the O-rings greased on the Qiagen EZ1 robots.  Maintenance 
actions will be recorded on the Qiagen EZ1 Maintenance Worksheet.  A volume test will be conducted every six 
months to monitor the pipetting accuracy of the robots.  Results of the volume test are recorded on the 
BioRobot EZ1 Volume Test Worksheet. 
 

6.5.1. CLEANING THE PIERCING UNIT: 
 
The piercing unit cleaning protocol can be accessed using either the DNA Investigator Card or the Volume 
Test Card.  If only a cleaning is required, use the DNA Investigator Card; if a volume test is also due, then use 
the Volume Test card.  This will limit the number of times the machine is turned on and off and cards are 
switched.  Never remove or insert a card when the machine is on.  The DNA Investigator Card 
should always be in the machine so that it ready for use. 

 
1. With the robot off, insert the Volume Test Card or ensure that the DNA Investigator Card is in the card 

slot. 
 
2. With the door closed, turn the machine on. 
 
3. Press 1. Protocols. 
 
4. Press 3. Clean piercing unit.  The piercing unit will move forward and downward. 
 
5. Open the door by lifting up, and clean the piercing unit with reagent alcohol. 
 
6. Close the door and press Esc when finished. 
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6.5.2. GREASING THE O-RINGS: 

 
Apply a small amount of silicon grease to the top of a filter tip and use it to apply the grease to the tip adapters.  
Wipe off any excess grease with a tissue. 

 
6.5.3. VOLUME TEST: 

 
The volume test requires the use of the Volume Test Card. 

  
1. With the machine turned off, insert the Volume Test Card. 

 
2. For each robot to be tested, individually number and weigh six empty elution tubes with caps.  Record the 

weight of the empty elution tubes on the BioRobot EZ1 Volume Test Worksheet in the Qiagen EZ1 
Maintenance Log. 
 

3. Place the six empty elution tubes, without their caps, in row 1. 
 

4. Place six sample tubes containing 1mL of distilled water in row 4. 
 

5. Place six tips in tip holders in row 2. 
 

6. With the door closed, turn the machine on. 
 

7. Press the Start button.  The volume test will begin. 
 

8. When the test is complete, press Esc to exit the protocol and turn the machine off. 
 

9. Remove the Volume Test Card and insert the DNA Investigator Card. 
 

10. Replace the caps on the elution tubes and remove them from the machine. 
 

11. Weigh each tube, now filled with approximately 500 μL of distilled water. 
 

Record the weights of the water on the Volume Test Worksheet and calculate the variance.  Allowable 
variance is within 5% of the volume pipetted.  For the 500μL pipetted in the volume test, the allowable range 
is 474 to 525 μL.  Recall that 500μL is equal to 500mg. 
 
 

6.6. HAMILTON NIMBUS 4 MAINTENANCE  
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The Nimbus requires routine maintenance to be performed daily, weekly, and semi-annually in order to ensure 
optimal performance.  Any maintenance failures should be reported to Hamilton Technical Support (1-800-648-
5950) for troubleshooting assistance. 
Daily Maintenance: 
 
The daily maintenance should be performed prior to the first run of the day.  It is not necessary to perform the 
daily maintenance prior to subsequent runs if it has already been performed on a given day.  It is also not 
necessary to perform the daily maintenance on days the Nimbus is not used. 
 
1. Power on the Nimbus instrument and attached computer. 
 
2. Open the Maintenance software (on the desktop). 
 
3. Select the “Daily” maintenance type and click “Run Maintenance”. 
 
4. Inspect deck and carriers for cleanliness. 

a. Clean the deck with deionized water and/or ethanol. 
b. Wipe the o-rings on the channels with deionized water. 
c. Check the “Inspect deck and carriers for cleanliness” box. 

 
5. Empty Tip Waste/Liquid Waste. 

a. Remove the tip waste receptacle and empty tips into trash. 
b. Replace plastic trash bag in tip waste receptacle if needed. 
c. There is no liquid waste to empty. 
d. Check the “Empty Tip Waste/Liquid Waste” box. 

 
6. Select the “Check tightness of Pipetting Channels” box. 

a. Read the message that appears, remove the tip eject plate, close the door, and click “Continue”. 
b. The system will automatically test the o-ring seals of the channels. 

 
7. Select the “Check LLD” box. 

a. Read the message that appears, ensure the tip eject plate is still removed and the door is still closed, and 
click “Continue”. 

b. The system will automatically test liquid level sensing. 
 
8. Click “OK” to acknowledge that the maintenance has completed successfully. 
 
9. Replace the tip eject plate. 
 
10. Click “Close”. 
 
11. Exit the Maintenance software. 
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Weekly Maintenance: 
 
The weekly maintenance should be performed once a week regardless of whether or not the Nimbus is to be 

used that week. 
 
1. Power on the Nimbus instrument and attached computer. 
 
2. Open the Maintenance software (on the desktop). 
 
3. Select the “Weekly” maintenance type and click “Run Maintenance”. 
 
4. Clean deck and carriers. 

a. Clean the deck with deionized water and/or ethanol. 
b. Check the “Clean deck and carriers” box. 

 
5. Check condition of carriers and other devices. 

a. Visually inspect the instrument for any obvious signs of damage. 
b. Clean the pedestals and racks with water and/or ethanol. 
c. Check the “Check condition of carriers and other devices” box. 

 
6. Empty and clean Tip Waste/Liquid Waste. 

a. Remove the tip waste receptacle and empty tips into trash. 
b. Replace plastic trash bag in tip waste receptacle if needed. 
c. There is no liquid waste to empty. 
d. Clean the tip eject plate with deionized water and/or ethanol. 
e. Check the “Empty and clean Tip Waste/Liquid Waste” box. 

 
7. Clean each channel:  stop disk, o-ring, and tip eject sleeve. 

a. Wipe the pipettor channels with a kimwipe dampened with deionized water. 
b. Check the “Clean each channel:  stop disk, o-ring, and tip eject sleeve” box. 

 
8. Clean the side covers 

a. Clean the Nimbus enclosure with deionized water and/or ethanol. 
b. Check the “Clean the side covers” box. 

 
9. Select the “Check tightness of Pipette Channels” box. 

a. Read the message that appears, remove the tip eject plate, close the door, and click “Continue”. 
b. The system will automatically test the o-ring seals of the channels. 

 
10. Select the “Check cLLD” box. 

a. Read the message that appears, ensure the tip eject plate is still removed and the door is still closed, and 
click “Continue”. 

b. The system will automatically test liquid level sensing. 
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11. Click “OK” to acknowledge that the maintenance has completed successfully. 
 
12. Replace the tip eject plate. 
 
13. Click “Close”. 
 
14. Exit the Maintenance software. 
 
Semi-Annual Maintenance: 
 
At least once a year a service engineer from Hamilton will perform maintenance and calibration of the Nimbus. 
 
REFERENCES: 
 
Microlab® Nimbus Independent Channel Operator’s Manual.  Hamilton Robotics. 
Microlab® Nimbus Enclosed Version Operator’s Manual.  Hamilton Robotics. 
Microlab® Nimbus Independent Channel Programmer’s Manual.  Hamilton Robotics. 
 
6.7. QIACUBE MAINTENANCE 

 
6.7.1. MONTHLY MAINTENANCE  

 
1. Clean the optical sensor, tip adapter, gripper unit, including the gripper, the stabilizing rod, and the spin 

column lid holder, by carefully wiping these modules with a soft lint-free cloth moistened with water. To 
gain access to the modules within the robotic arm:  

a. Press “Tools” in the main menu.  
b. Select “Maintenance” by pressing the up/down arrows to scroll through the list until it is 

highlighted, and then press “Select”. 
c. Select “Cleaning position” by pressing the up/down arrows to scroll through the list until it is 

highlighted, and then press “Start”. 
d. Follow the instructions displayed in the touchscreen. You will be instructed to remove the waste 

drawer and the labware tray.  
The robotic arm will move forward and downwards, enabling the modules to be accessed for cleaning 
through the opening for the waste drawer. 
 

2. After cleaning the modules of the robotic arm, switch off the QIAcube at the power switch. 
  

3. Thoroughly wipe the worktable with a soft lint-free cloth moistened with cleaning agent. Incubate as 
appropriate, rinse with distilled water, and wipe dry with paper towels. 

 
4. Clean the shaker rack, labware tray, heating adapter, and reagent bottle rack with cleaning agent. Incubate 

as appropriate, rinse thoroughly with distilled water, and wipe dry with paper towels. 
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5. Clean the liner of the waste drawer with cleaning agent. Incubate as appropriate, rinse with distilled 
water, and wipe dry with paper towels. 

 
6. Thoroughly wipe the inside and outside of the QIAcube using the cleaning agents.  

 
Important: Do not use alcohol or alcohol-based disinfectants to decontaminate the QIAcube door.  
 
Important: Take care that no liquid runs down the touchscreen. Liquid may be drawn through the dust 
protection sealing by capillary forces and cause malfunction of the display. To clean the touchscreen, moisten a 
soft lint-free cloth with 70% ethanol or a mild disinfectant and carefully wipe the display. Wipe dry with a 
paper towel. 

  
6.7.2.  SEMI-ANNUAL MAINTENANCE 

 
The centrifuge lid must be open to allow access to the inside of the centrifuge. The lid should be opened only 
after the centrifuge has come to a complete stop. If the lid does not open automatically, perform the following 
steps.  
1. Press “Tools” in the main menu. 
 

2. Highlight “Maintenance” (scroll through the list by using the up/down arrows), and press “Select”. 
 

3. Highlight “Open lid” (scroll through the list by pressing the up/down arrows), and press “Select”.  
 
Cleaning the rotor and buckets 
  
1. Switch off the QIAcube at the power switch. 

  
2. Remove used disposable labware, sample tubes, and reagents from the worktable. Discard according to 

your local safety regulations. 
 

3. Close the buffer bottles tightly, and store according to the instructions in the relevant kit handbook. 
 

4. Remove all disposable rotor adapters, including tubes and spin columns, from the buckets. 
 

5. Remove the buckets from the rotor. Undo the rotor nut on top of the rotor using the rotor key, and 
carefully lift the rotor off the rotor shaft. 

 
6. Submerge the rotor, buckets, and rotor nut in cleaning agent. Incubate as appropriate. 

 
7. Rinse thoroughly with distilled water. Use a brush (i.e., a toothbrush or tube brush) to clean any parts 

that are difficult to access, such as the bucket mount and the rotor head. Wipe surfaces dry with a soft lint-
free cloth. If available, dry the buckets and rotor with pressurized air. 
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Important: Make sure the paper towels and brush used are lint-free. 
 
Important: Make sure that all residual salt is removed. 
 
Important: Make sure to remove all traces of cleaning agent from the centrifuge buckets. Residual agent 
can cause the buckets to jam. 

 
8. Apply a few drops of mineral oil (Anti-Corrosion Oil (rotor), cat. no. 9018543) on a soft, lint-free cloth, 

and wipe the bucket mount and rotor claw. A thin, invisible oil film should cover the bucket mount and 
rotor claw, but no droplets or smear should be apparent. 
  

9. Apply oil to the rotor claw and to the bucket mount.  
 

Important: Before applying oil to the rotor buckets on the rotor, make sure that the rotor and all buckets are 
completely dry. 

 
Cleaning the centrifuge  
 
1. Moisten a soft lint-free cloth with cleaning agent, and clean the inside of the centrifuge and the centrifuge 

gasket. Incubate as appropriate. 
  

2. Clean the inside of the centrifuge and the gasket with distilled water, and wipe dry with lint-free paper 
towels. If available, use a vacuum cleaner.  

 
Important: Make sure the gaskets remain in the proper positions. 

   
3. Clean the centrifuge lid with a soft lint-free cloth moistened with cleaning agent. Incubate as appropriate, 

clean with water, and wipe dry with paper towels. 
  

4. Check the centrifuge gasket for damage. If the gasket is damaged or shows signs of wear, contact QIAGEN 
Technical Services.  
 

Installing the centrifuge rotor and buckets 
 

1. Mount the rotor. The rotor can be mounted in only one orientation. The pin on the rotor shaft fits into a 
notch on the underside of the rotor directly underneath rotor position 1. Line up position 1 of the rotor 
with the pin on the rotor shaft and carefully lower the rotor onto the shaft. Install the rotor nut on top of 
the rotor and tighten using the rotor key supplied with the QIAcube. Make sure that the rotor is securely 
seated. 
  

2. Replace the rotor buckets. When replacing the rotor buckets, the side of the rotor bucket that must face 
toward the rotor shaft is marked with a gray line. Hold the bucket at an angle with the gray line facing the 
center of the rotor and hang the bucket on the rotor. Check that all buckets are properly suspended and 
can swing freely.  
 

Important: All centrifuge buckets must be mounted before starting a run. 
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Tightness Test 

The tightness test is performed to check whether the tightness of the pipetting system, including the attached 
pipetting tip, is sufficient.  

1. Load an empty 2 ml safe- lock microcentrifuge tube in position 1 of the shaker. 
  

2. Fill a reagent bottle with 96% ethanol and place in position 1 of the reagent bottle rack. 
 

3. Load a tip rack of the filter tips you want to test (1000 μl or 1000 μl wide-bore) onto the QIAcube. 
 

4. Make sure that the QIAcube is switched on. 
 

5. In the main menu, press “Tools”. 
 

6. Select “Maintenance” by pressing the up/down buttons to scroll through the list until it is highlighted, and 
then press “Select”. 

 
7. Select “Tightness test” by pressing the up/down buttons to scroll through the list until it is highlighted, 

and then press “Select”. 
 

8. Select the appropriate type of filter-tips (“1000 μl tips” or “1000 μl wide-bore tips”) by pressing the 
up/down buttons to scroll through the list until it is highlighted, and then press “Select”. 

 
9. Press “Start” to start the tightness test with the selected type of filter-tips. 

 
10. Follow the instructions displayed in the touchscreen, and press “Start” to start the tightness test. After the 

load check, the robotic arm will pick up a tip, aspirate ethanol, and move to the tube. The tip will remain 
in place above the tube for 2 minutes. The tip will be detached. 

 
11. After the protocol is completed, open the QIAcube door and check if the tube contains liquid. If the tube 

is still empty and dry, the tightness of the pipetting system is adequate. If you find liquid in the tube, 
contact QIAGEN Technical Services.  

  
6.7.3. ANNUAL MAINTENANCE 

 
A Qiagen Service Engineer will perform maintenance on an annual basis. 
 

 
6.8. QIASYMPHONY MAINTENANCE 

 
6.8.1. DAILY MAINTENANCE 

 
After every day in which the QIAsymphony is run: 
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Tip Disposal Chute 
  
1. Remove, clean, and rinse the tip disposal chute. Ensure it is dry before reinstalling. 
 
Liquid Waste Container 
 
1. Remove and empty the liquid waste container into the waste barrel for EZ1 reagents. 

  
2. Clean and rinse the liquid waste container. 

 
3. Replace liquid waste container. Note: the liquid waste container can be autoclaved (121oC for 20min). 

 
Drawers and lysis station 

1. Remove all removable objects (tube/plate carriers, adapters, inserts, liquid waste station/tip park station, 
tip disposal chute, liquid waste bottle) from the drawers. 
 

2. Wipe the drawers and the removed objects as well as the lysis station with ethanol-based disinfectant and 
incubate as appropriate. Then wipe with a cloth moistened with water and dry with paper towels. Return 
the objects to the drawers. 
 

3. Optional: Clean the removed objects by soaking them in a glyoxal and quaternary ammonium salt based 
disinfectant (e.g., Lysetol AF). 

 
Important: There are spikes below the piercing device in the “Reagents and Consumables” drawer that ensure 
that the reagent cartridge is correctly positioned. Take care when cleaning the “Reagents and Consumables” 
drawer. 
Robotic Gripper 
 
1. Wipe the robotic gripper with a lint-free cloth moistened with ethanol-based disinfectant. Incubate as 

appropriate. Important: Only wipe the weight. Do not wipe the rods otherwise the ball mechanism may 
become jammed. 

2. Wipe with a lint-free cloth moistened with water and dry with paper towels. 
 
WEEKLY MAINTENANCE 
 
In every week in which the QIAsymphony is run: 
 
Drawers and Lysis Station 
 
1. Remove tube/plate carriers, adapters, and inserts and soak them in disinfectant (e.g., Lysetol AF). 

Incubate for at least 15 min, then rinse with water and dry with paper towels. 
2. Check the condition of the bar code labels and make sure that they are not scratched. 
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Touch Screen 
 
Wipe the touch screen with ethanol-based disinfectant and incubate as appropriate. Then wipe with a cloth 
moistened with water and dry with paper towels. 
 
QIAsymphony Hood 
 
Wipe the surface with a soft lint-free cloth moistened with deionized water. Then dry with a dry soft lintfree 
cloth or paper towel. Important: Do not use ethanol-based disinfectant. 
 
Pipetting System and Guards 
 
1. Remove all 4 tip guards by pushing each tip guard upward until it clicks out of place and can be removed. 
2. Soak in a glyoxal and quaternary ammonium salt based disinfectant (e.g., Lysetol AF) for at least 15 min. 
3. Rinse with water and wipe dry with paper towels. Make sure to replace the tip guards before operating 

the instrument. 
 
O-Ring Tightness Test 
 
The tightness of the tip adapter O-ring should be checked weekly and the O-ring must be changed monthly.  
 
1. In the “Tools” screen, press “Service SP” or “Service AS”. Then select the service script 

“CheckPipettingChannelORing.lua”. 
2. Press “Start” to start the tightness test. 
3. Follow the instructions in the messages displayed on the touchscreen. When instructed to do so by the 

software, place an empty tip-rack containing 4 test tips into the tip rack slot shown in the software 
message (see picture on next page). Note: Do not start an inventory scan during the protocol run. When 
the inventory scan message appears, press “No, nothing changed”. 

4. If after running the tightness test for a particular tip adapter a message is displayed with “Failed”, the O-
ring must be changed. If one tip adapter fails the tightness test, we recommend changing all 4 O-rings at 
the same time.  

 
6.8.2. MONTHLY MAINTENANCE 

 
Magnetic Head 

1. Remove the cover from the magnetic head. 
2. Wipe the exterior of the magnetic head with a lint-free cloth moistened with ethanol-based disinfectant 

and incubate as appropriate. 
3. Wipe with a lint-free cloth moistened with water and dry with paper towels. 
 
Magnetic Head Guards 
 
1. Check the magnetic-head guards. If required, clean before starting the next protocol run. 
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2. Open the “Maintenance” menu and run the service protocol “MH guard”. Gently raise the catches to 
release the magnetic-head guards. 

3. Wipe the magnetic-head guards with ethanol-based disinfectant and incubate as appropriate. 
4. Wipe with a lint-free cloth moistened with water and wipe dry with paper towels. Replace the magnetic-

head guards. 
5. Open the “Maintenance” menu and run the service protocol “MH guard open”. Make sure to replace the 

magnetic-head guards before operating the instrument. 
 
Conveyer Base Tray 
 
1. Carefully remove the conveyor base tray from below the magnetic head. 
2. Soak in a glyoxal and quaternary ammonium salt based disinfectant (e.g., Lysetol AF) for at least 15 min. 
3. Rinse with water and wipe dry with paper towels. Note: The tray can also be autoclaved at 121°C for 20 

min. 
 
O-Ring Replacement 
 
The O-rings must be changed every month using the “O-Ring Change Tool Set” (cat. no. 9019164). 
 
Using the “O-Ring Change Tool Set” to perform O-ring change  
Before removing the old O-ring, the new O-ring must be prepared. These steps should be performed for both 
the QIAsymphony SP and the QIAsymphony AS instruments. For instructions, refer to the quick guide that is 
included with the “O-Ring Change Tool Set” (cat. no. 9019164).  

 
6.9. 7500 SDS CALIBRATION / VERIFICATION PROCEDURES 

 
The information for the procedures detailed in this section was taken from the Applied Biosystems 
7300/7500/7500 fast real-Time PCR System Installation and Maintenance Guide.   When the yearly calibration 
checks are performed, the analyst performing the calibration must check the lamp usage and status. Procedure 
6.8.7.1 details checking the lamp usage and status.  The halogen lamp located in the 7500 SDS Instrument has a 
life span of approximately 1,000 hours.  If the lamp has exceeded 1,000 hours, or if a message is displayed that 
recommends changing the lamp, procedure 6.8.7.2 should be followed. 
 

6.9.1. BLOCK CONTAMINATION CHECK 
 

Purpose:  A check for contamination allows a user to determine if there are any areas of possible contamination 
in the wells of the plate holder that would artificially increase the fluorescence in those wells during a run, 
thereby increasing the quantitation result. 
 
Preparing the Check  This check is performed without a plate being positioned in the plate holder; therefore, if 
there is a plate in the holder, remove it, and then close the carriage door over the sample block and lock it 
down.   
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Note:  This check is for information only and should not be saved using the 7500 System software during or 
after the check.  See step 3 below for instructions on documenting the contamination check. 
 
Performing the Check 

 
1. Turn on the instrument and open the SDS software. Click File>New. In the new document wizard click 

Finish to accept the default parameters.  
  

2. Click on the “Instrument” drop-down menu and select “Calibration”. Click “Yes” to lower the block. In 
the “Calibration” window select Filter A (FAM filter position), open the ROI Inspector and take an image 
at 2048ms by selecting Snapshot. 
 

3. Observe the background fluorescence in the 96 wells.  Note any wells that have significant fluorescence; 
fluorescence indicates contamination.  For documentation, perform a Screen Shot (Alt + PrintScrn) and 
then paste it (Ctrl-V) into a Microsoft Word blank document. 
 

4. To determine an acceptable background fluorescence level: 
a. Push the instrument carriage and allow it to spring back to open it. 
b. Put a new, clean, empty reaction plate without the cover into the sample block. 
c. Push the carriage forward to close it. 
d. Take another image at 2048 ms.  For documentation, perform a Screen Shot (Alt +PrintScrn) and 

then paste it (Ctrl-V) into a Microsoft Word blank document. 
e. Save as Calibration Contamination check (MM/DD/YY) in the appropriate instrument folder. 

 
5. If some of the wells still appear to have significant fluorescence, clean them per the instructions in 

“Cleaning the Sample Wells”. 
 

Recheck the wells after cleaning, following steps 1 through 3 above. 
 

6.9.2. 7500 REGIONS OF INTEREST CALIBRATION 
 

MATERIALS REQUIRED: 
 

1. Applied Biosystems Real-Time PCR System Spectral Calibration Kit 
 

2. ROI Calibration Plate (Part No. 4349415)   
 

3. Centrifuge and vortex 
 

Purpose: 
A Regions of Interest (ROI) calibration maps the positions of the wells on the sample block so that the 
software can associate increases in fluorescence during a run with specific wells of the plate.  A calibration 
image is needed for each well or filter to account for minor differences in the optical path. 
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Preparing the Plate 
Retrieve the ROI calibration plate from the spectral calibration kit from the freezer in the amplified DNA 
room freezer.  Allow the plate to thaw.  Leave the optical film on the plate. (Do not discard the packaging as 
the plate can be used up to three times).  Vortex and centrifuge the thawed plate to assure that the liquid is in 
the bottom of the plate wells. 

 
Creating a Plate Document for the ROI Calibration 

 
1. Start the instrument and open the SDS software.  Load the ROI calibration plate into the plate holder 

position. 
 

2. Click File > New  
In the New Document wizard or dialog box click Finish to accept the default parameters.  (The SDS 
software automatically saves the ROI data to a set of calibration files on the computer hard drive).   Click 
OK if any ROI error is displayed. 
 

3. In the SDS software, select Instrument > Calibrate 
  

4. In the ROI inspector dialog box that appears, right-click the black area of the window, then select 
Display Properties. 
 

5. In the Image Viewer Control Properties dialog Box: 
a. Select Show Saturation 
b. In the Sat Threshold field, enter 4000. 
c. Click OK 
 

6. In the ROI Inspector dialog box, set the lamp control: 
a. Click Block up 
b. Select Idle from the Lamp Control drop-down list  
 

Performing the ROI Calibration 
 

1. In the ROI Inspector dialog box: 
a. In the Exposure Time field, enter 2048 for the 7500 and  
b. Select Filter A. 
 

2. Click Snapshot to generate an ROI image. 
 

3. Determine if your ROI image is acceptable.  An acceptable image will not have saturated red areas in any 
wells.  (A few red pixels in a well are acceptable).   
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If the ROI image appears over saturated, continue to reduce the number in the Exposure Time Field 
(2048) by half until an acceptable image is obtained.  Once the acceptable image is produced, print this 
screen by pressing Alt + PrintScrn and then Ctrl V into a Microsoft Word blank document. 
 

4. If your image is acceptable, Click Generate Calibration. 
The software takes a snapshot, and then displays a message dialog box or an ROI image.  A successful 
calibration will have green circles around all wells. 
  
If the calibration image is not successful, see pg 45 for of the 7500 Installation and Maintenance Guide for trouble 
shooting. 
 

5. Click Save Calibration to save the image for filter A.  (An OK will appear in the dialog box for Filter 
A).  Remember to Save after every filter. 
 

6. Repeats steps 1 through 6 for the remaining filters:  Filters B, C, D and E.  Reset the Exposure Time to 
2048 before performing the calibration for each filter. 
 

7. Click Done > File > Close and click NO to save the plate document. 
 

Unloading the Plate  
 

In the ROI Inspector dialog box, click Block Down and remove the plate.  Return the plate to the packaging if 
not performing background and optical calibration. 

 
6.9.3. Performing the Background Calibration on the 7500 SDS Instrument 

 
MATERIALS REQUIRED: 
 
1. Applied Biosystems Real-Time PCR System Spectral Calibration Kit 
 
2. Background Plate (Part No. 4330124) 
 
3. Centrifuge and vortex 

 
Purpose  A background calibration measures the level of background fluorescence in the instrument.  The run 
will perform continuous reads of a background plate containing PCR buffer for 10 minutes at 60°C and 
average the spectral results to a calibration file.  The software can then use the file to remove the background 
fluorescence from the run data. 
 
Perform a background calibration after replacing the lamp or monthly, depending on instrument usage. 
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Precautions Since the signal consists of fluorescence from several sources it is important to use gloves when 
handling the plate, use a clean centrifuge and vortex, and do not place the plates on the lab bench. 

 
Preparing the Background Calibration Plate  Retrieve the prepared background plate from the spectral 
calibration kit from the freezer in the amplified DNA room.  Allow the plate to thaw (Do not discard the 
packaging as the plate can be used up to three times).  Vortex and centrifuge the thawed plate to ensure that 
the liquid is in the bottom of the plate wells. 

 
Creating a Plate Document for the Background Calibration 
 
1. Place the prepared plate into the plate holder and close the tray/door.  Start the instrument and open the 

SDS software.  Click File > New. 
 
2. Configure the New Document Dialog box: 

a. Select Assay >Background.   
b. Select Container > 96-Well Clear.  
c. Select Template > Blank Document 
d. In the Operator field, enter a name. 
e. In the plate Name field, enter : Background_<date MMDDYY> and click Finish. 

 
3. In the SDS software select File > Save As.  On 7500 #1, navigate to C:\SDS1.2\Documents and save.  

On 7500 #2, navigate to D\: > SDS 1.2 >SDS Documents and save.  Select Save as type > SDS 
Documents (*.sds). 

 
Performing the Background Calibration  In the SDS software: Select the Instrument tab and click Start.  The 
instrument begins the calibration run after the heated cover comes to temperature.   After the run is complete, 
click OK.  The background run may take 10 minutes.   

 
Analyzing the Background Calibration Data 
 
1. Click the green arrow or select Analysis > Extract Background.  The software extracts the 

background signal then displays Background Extraction Complete.  Click OK.   
 

If the message indicates the image exposure is too low, see pg 56 of the 7500 Installation and Maintenance Guide for 
trouble shooting. 

 
2. In the plate document, select the Results tab, then Spectra tab.  Print this page for the Background 

Calibration records and to show that the instrument is free of significant contaminants.  
 
3. Inspect the raw data for irregular spectral peaks that exceed the following fluorescent standard units 

(FSU).  All wells should be selected.  
 

Not 
for

 La
bo

rat
ory

 U
se



Unit Policy Manual 
Forensic Biology 

Forensic Biology Unit Policy Manual v07-09-2020  Page 63 of 86 

Filter FSU 

A,B,C,D 
(7000/7500) 

>72,000 

E (7500) >90,000 

 
If the fluorescence exceeds the FSU indicated, see pg 64 of the 7500 Installation and Maintenance Guide for trouble 
shooting. 
 
If a contaminant is observed (high fluorescent data), see pg 108 of the 7500 Installation and Maintenance Guide for 
cleaning contaminants. 

 
4. Inspect the background plate image for bright areas of fluorescence and perform a Screen Shot (Alt + 

PrintScrn) and then paste it (Ctrl-V) into a Microsoft Word blank document for documentation. 
  

5. Select File > Close 
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6.9.4. PERFORMING THE OPTICAL CALIBRATION FOR THE 7500 SDS INSTRUMENT 
 

MATERIALS REQUIRED: 
 

1. Applied Biosystems Real-Time PCR System Spectral Calibration Kit 
 
2. ROI Calibration Plate (Part No. 4349415) 
 
3. Centrifuge and vortex 

 
Purpose:  The optical calibration compensates for the physical effects of the additional filter present in the 
7500 instrument and needs to be performed after every 7500 system background calibration. 

 
Preparing the Optical Calibration Plate 
Retrieve the prepared ROI plate from the spectral calibration kit from the freezer in the amplified DNA room.  
Allow the plate to thaw (Do not discard the packaging as the plate can be used up to three times).  Vortex and 
centrifuge the thawed plate to ensure that the liquid is in the bottom of the plate wells. 

 
Creating a Plate Document for the Optical Calibration 
 
1. Start the instrument and open the SDS software.  Load the ROI calibration plate into the plate holder 

position. 
  
2. Click File>New. 
 
3. Configure the New Document Dialog box: 

a. Select Assay >Calibration.   
b. Select Container > 96-Well Clear.  
c. Select Template > Blank Document 
d. In the Operator field, enter a name. 
e. In the plate Name field, enter : 
 Calibration_<date MMDDYY> and click Finish. 

4. In the SDS software select File > Save As.  On 7500 #1, navigate to C:\SDS1.2\Documents and save.  
On 7500 #2, navigate to D\: > SDS 1.2 >SDS Documents and save. 

 
Performing the Optical Calibration 
In the SDS software: Select the Instrument tab and click Start.  The instrument begins the calibration 
run (10 min.) after the heated cover comes to temperature.  After the run is complete, click OK. 
 
Analyzing the Optical Calibration Data 
Click the green arrow or select Analysis > Extract.  The software extracts the optical calibration then 
displays a message indicating the extraction is complete.  Click OK. 
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Click on the Results and Spectral Tabs.  Select all wells and print this screen.  Inspect the raw background 
data for any irregular spectral peaks. 
 
For any error messages, see pg 64 of the 7500 Installation and Maintenance Guide for trouble shooting 

 
Click File>Close. 

6.9.5. PERFORMING THE PURE DYE CALIBRATION ON THE 7500 SDS INSTRUMENT 
 

MATERIALS REQUIRED: 
 
1. Applied Biosystems 7500 Real-Time PCR Systems Spectral Calibration Kit I  
(PN 4349180 containing Pure Dye Plates FAM, JOE, NED, ROX, SYBR Green, TAMRA, and VIC). 
 
2. Centrifuge and vortex 

 
Purpose  During a pure dye calibration run, the system collects spectral data from a series of pure dye 
standards and stores the spectral information for the pure dye standards in the pure spectra run file, a 
calibration file in the SDS directory. 
 
The software then uses the pure spectra data during subsequent runs to characterize pure dyes and distinguish 
the individual contribution of each dye in the collective fluorescence collected by the instrument during a run. 
 
Important!  Before performing a pure dye calibration, you must perform an ROI calibration, a background 
calibration, and an optical calibration. 
 
Preparing the Plate Retrieve the pure dye plates from the spectral calibration kits from the freezer in the 
amplified DNA room.  Allow the plates to thaw (~5 minutes).  NOTE:  Do not remove a pure dye plate 
from its packaging until it is ready to be used.  The fluorescent dye in the wells of each pure 
dye plate is photosensitive.  (Do not discard the packaging as the plates can be used multiple times).  
Leave the optical film on the plates.  Although multiple pure dye plates are in Spectral Calibration Kit I, only 
the plates that are currently used for the quantitation chemistry being employed need to be run.  For 
Quantifiler and Quantifiler Duo, only FAM, VIC, ROX, and NED need to be run. 
 
Creating a Plate Document for the Pure Dye Calibration 
 
1. Start the instrument and open the SDS software.  Click File > New. 
 
2. In the New Document Wizard dialog box: 
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a. Select Assay > Pure Spectra. 
b. Select Container > 96-Well Clear. 
c. Select Template > Blank Document. 
d. In the Operator field, enter your initials. 
e. In the Comments field, enter the plate bar code number. 
f. Click Finish.  Note:  It is not necessary to name or save the pure dye plate document.  The SDS 

software automatically saves the pure dye data to a calibration file on the computer hard drive. 
 
Selecting the Dye 
 
In the Pure Spectra Calibration Manager dialog box: 
 

a. In the Dye List field, select a pure dye to calibrate. 
b. Click Calibrate. 
c. If you are prompted to disconnect the plate document, click Yes. 
d. A message prompts you to load the plate.  Do not click Yes or No at this point. 

 
Preparing and Loading a Pure Dye Plate 
 
1. Remove the appropriate Pure Dye plate from its packaging.  Do not discard the packaging as the plate can 

be used multiple times.  Leave the optical film on the plate. 
2. Vortex and centrifuge the thawed plate to assure that the liquid is in the bottom of the plate wells. 
3. Verify that the pure dye plate that you are about to load matches the dye selected in the Pure Spectra 

Calibration Manager. 
4. Load the plate in the instrument with the notch in the upper right corner. 
 
Performing the Pure Dye Calibration 
 
1. In the dialog box that prompts you to load the plate click Yes.  The run takes ~5 minutes to complete. 
2. When the SDS software completes the run, remove the pure dye plate from the SDS Instrument, place it 

back into its packaging, and place it back into its respective spectral calibration kit in the freezer. 
 
Calibrating remaining dyes: 
 
1. Click Next Dye >. 
2. Repeat the procedures in Preparing and Loading a Pure Dye Plate and Performing the Pure Dye 

Calibration to run the remaining pure dye plates. 
 
3. After you calibrate the instrument with all pure dyes provided in the spectral calibration kits, click 

Finish. 
 
Analyzing the Pure Dye Calibration Data Not 
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When each pure dye plate is run, the SDS Software automatically creates and saves a plate document for each 
dye.  After you calibrate all of the pure dye plates, the plate documents remain open behind the plate 
document displayed by the software.  To complete the calibration, analyze all open pure dye documents: 
 
1. From the Windows menu, select the plate document to analyze. 
2. Select the Results tab, then select the Spectra tab. 
3. Select all wells of the plate document by clicking the upper-left corner of the plate grid. 
4. Click the green arrow (or select Analysis > Extract Pure Spectra).  The SDS Software completes the 

extraction, then displays a message: 
 

If the software displays: Do this: 
Pure Spectra Extraction Complete – The analysis 
is successful. 

Click OK, then go to step 5. 
Important!  The pure dye 
calibration is not complete at this 
point.  Before closing the plate document 
you must inspect the Spectra plot as 
explained in steps 5 through 8 below. 

Repair Message—“The following wells require 
repair. . .” 

Click OK, then go to step 5. 
(For information on how the software 
auto-repairs calibration spectra, see 
“About Pure Dye Spectra” on pg 79 of the 
Applied Biosystems 7300/7500/7500 Fast 
Real-Time PCR System Installation and 
Maintenance Guide. 

Error Message—“Pure Spectra Extraction 
Detected an Unknown Error. . .” 

Click OK, load the plate, then run the 
pure dye plate again. 
If the calibration continues to fail, perform 
the calibration with a new pure dye plate. 

 
5. In the pure dye plate document: 
 

a. Select the Results tab. 
b. Select the Spectra tab. 

 
6. Select all wells of the plate document by clicking the upper-left corner of the plate grid. 
 
7. Using the tables below as a reference, verify that the peak for the spectrum of the pure dye occurs at the 

correct filter.  For documentation, Print the spectra for each dye (Alt + Print Scrn; then open a new 
blank Microsoft Word document and Ctrl V to paste the spectra).  If the peak for the spectra of a dye Not 
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occurs in the wrong filter, you may have run the wrong dye plate during the calibration.  Repeat the 
procedure using the correct dye.   

 

 
 
8. Select File > Close.  Important!  Do not close a plate document until you have extracted it.  During 

the calibration, the software creates plate documents for each pure dye plate as it was run.  You must 
extract each one individually before closing it. 
  

9. Repeat steps 1 through 8 to extract the calibration data for the remaining pure dyes. 
 

6.9.6. Running the TaqMan RNase P Plate Data on the ABI 7500 SDS 
 
MATERIALS REQUIRED: 
 
1. Applied Biosystems Real-Time PCR System Spectral Calibration Kit 
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2. TaqMan RNase P Instrument Verification Plate (Part No. 4350584) 
 
3. Centrifuge and vortex 
 
Purpose  The TaqMan RNase P Instrument Verification Plate run verifies the performance of an Applied 
Biosystems 7500 SDS instrument.  The RNase P plate is pre-loaded with the reagents necessary for the 
detection and quantification of genomic copies of the human RNase P gene. 
 
The RNase P plate contains five replicate groups of standards, two unknown populations and four no template 
control wells.  After the run, the SDS software will assess the instrument performance.   
 
Preparing the TaqMan RNase P Plate  Retrieve a prepared TaqMan RNase P Verification Plate kit from the 
freezer in the amplified DNA room and allow the plate to thaw (approximately 5 minutes).  Vortex and 
centrifuge the thawed plate to ensure that the liquid is in the bottom of the plate wells.  If the RNase P plate 
has a compression pad on it, remove it from the plate. 
 
Creating a Plate Document for the RNase P Verification Run 
 
1. Start the instrument and put the RNase P plate in the instrument. 
  
2. Open the SDS software and click File > New. 
 
3. In the New Document Dialog box: 

a. Select Assay >Absolute Quantification (standard curve).   
b. Select Container > 96-Well Clear.  
c. Select Template > AQ RNase P Install 
d. In the Operator field, enter a name for the RNase P plate (i.e. RNase P MMDDYY) click Finish 
e.    In the SDS software, select File> Save As.  (Navigate to D\:>AppliedBiosystems>SDS Documents 

and Save) 
 
Performing the Verification Run  In the SDS software: Select the Instrument tab and click Start.  (The 
instrument default parameters should be correct. The RNase P plate volume is 50ul). The instrument begins 
the run which lasts approximately 1.5 hours.  After the run is complete, click OK. 
 
Analyzing the TaqMan RNase P Plate Data 
 
1. Select Analysis > Analysis Settings. Select Auto Ct >Click OK.  Click the green arrow or select 

Analyze. 
 
2. Assess the results.  In the plate document: Select the Results tab then select the Amplification Plot 

tab. 
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4. Display the data: from the Amplification Plot tab: 
 

a. Click the upper-left corner of the plate grid to select all wells. 
 
b. Select Data > Ct vs. Well Position to display the plots.  Save this data. 

 
5. Verify the uniformity of each replicate population by comparing the groupings of Ct values. 
 

If outliers are present, omit and reanalyze (see page 93 of the 7500 Installation and Maintenance Guide for 
trouble shooting, this will apply to the 7000, as well). 

 
6. In the results tab, select the Standard Curve tab and verify that the R2 value is > 0.990. Save and print 

this data. 
 
7. In the Report tab, calculate the verification value of the 5,000-copy and 10,000-copy populations: 
 

a. For the 5,000-copy populations, in the Report tab, scroll to a sample in the 5K population.  Apply the 
value in the Mean Qty and StdDev Qty columns to the following equation:  

 
5K value = Mean Qty + 3(StdDev Qty) 

 
b. For the 10,000-copy populations, in the Report tab, scroll to a sample in the 10K population.  Apply 

the value in the Mean Qty and StdDev Qty columns to the following equation: 
 

10K value = Mean Qty – 3(StdDev Qty) 
 

8. Compare the values of the 10K and 5K-copy populations.  If the 10K value is greater than the 5K value 
the 7500 has passed. 

 
9. With all wells chosen, print the Report.  Save the Tabular Report Data and the Standard.  You may 

discard the Raw Data and the Delta Rn vs Cycle Data pages.  It is recommended that the calculations 
performed above be written on one of the Tabular Report Data pages. 

 
10. Close Program.  If asked to Save, click “yes”. 

 
Remove the plate and discard.  (Note: the plate cannot be re-used) 
 

 
6.9.7. Comparison of the RNase P Plate results between instruments and between years 

  
6.9.7.1. Between Instrument Sensitivity Assessment 
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To monitor for drift in sensitivity between instruments the Ct values of the RNase P standards 
from the two instruments will be compared to determine whether the instrument sensitivities 
are equivalent. This will be accomplished by performing a t-test on the average of the values 
obtained for each of the RNase P plate standards. 
 
Any statistically significant difference between the instruments that is detected will necessitate a 
change in the lamps for both instruments. 
  

6.9.7.2. Year-to-year sensitivity Assessment 
 
To monitor for drift in sensitivity over time the Ct values of the RNase P standards from the 
previous year for the two instruments will be compared to the results from the current year 
determine whether the instrument sensitivities are equivalent over time. Assuming the Ct 
values between instruments (6.9.7.1) are found to have no statistically significant difference, the 
year-to-year assessment will be accomplished by performing a t-test on the average of the values 
obtained for the RNase P plate standards from the current year to those of the previous year. 
 
Any statistically significant change that demonstrates a decrease in sensitivity will require a 
change in lamps for both instruments. 

  
6.9.8. Monitoring and Replacing the Lamp on the 7500 SDS Instrument 

 
6.9.8.1. Monitoring the Lamp Status 

 
The halogen lamp located in the 7500 SDS Instrument has a life span of approximately 1,000 hours, or 
two years (whichever comes first).  If the lamp has exceeded 1,000 hours, or if a message is displayed that 
recommends changing the lamp, procedure 6.8.7.2 should be followed. 
 
1. Select File > New. 
 
2. In the New Document Wizard, click Finish. 
 

In the SDS Software, select Instrument>Lamp Status/Replacement.  In the Lamp 
Status/Replacement dialog box, the usage hours and lamp current are displayed.  The Condition field 
will indicate one of the following: 

 
Good—the lamp is functioning well. There is no need to replace the lamp bulb at this time.  Click 
Close. 
Failed—The lamp bulb must be replaced.  Click Close, then replace the lamp. 
Change Soon—the lamp bulb usage is above 2000 hours. It is recommended to replace the lamp 
soon.  Click Close, then replace the lamp. 
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Warning messages may be displayed before or during a run that indicate low lamp current.  See page 121 of the 
Installation and Maintenance Guide for these messages, what they are describing, and how to proceed. 

 
6.9.8.2. Replacing the Halogen Lamp on the 7500 SDS Instrument 
 
The halogen lamp located in the 7500 SDS Instrument has a life span of approximately 1,000 hours.  If the 
lamp has exceeded 1,000 hours, or if a message is displayed that recommends changing the lamp, this 
procedure should be followed. 

 
MATERIALS REQUIRED: 
 
1. Halogen bulb (12V, 75W) 
 
2. Small pointed object, for example a screwdriver. 
 
Important:  Wear powder-free gloves when you handle the lamp. 
 
1. Power off, then unplug the 7500 SDS Instrument.  Allow the instrument to cool for 15 minutes. 
 
2. Open the access door to the Instrument: 
Insert a thin screwdriver or other object into the keyhole on the edge of the front access door, then push 

to unlatch the door.  Open the door. 
 
3. Remove the lamp from the instrument: 
Slide the lamp release lever downward.  Firmly grasp the lamp and lift it up and out of the slotted mount. 
 
4. Inspect the lamp for signs of failure (see the Installation and Maintenance Guide page 124 for 

indications of lamp failure). 
 
5. Place the new lamp into the instrument 
Slide the lamp release lever upward.  Firmly grasp the lamp, place it into the slotted mount, then carefully 

slide the lamp downward into place. 
  
6. Close the access door. 
 
7. Plug in and power on the 7500 SDS Instrument. 
 
8. Open the 7500 System software program. 

 If the Quick Startup document dialog box is not open, select File > New.  In the New Document 
wizard, click Finish.  In the SDS software, select Instrument > Lamp Status/Replacement and 
click on Reset lamp timer then close. 
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9. In the ROI Inspector dialog box, select Lamp Control > Idle. 
 
10. While the instrument is running, look through the grating of the access door and verify that the lamp 

is illuminated, then click Done. 
 
Important!  After replacing the lamp, the following calibrations must be performed:  ROI Calibration, 

Background and Optical Calibrations, Pure Dye Calibration, Instrument Performance Verification 
(RNase P Plate). 
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6.10. PROCEDURE FOR THE CALIBRATION CHECKS OF THE THERMOCYCLERS 
 
The thermal cyclers used for the polymerase chain reaction amplification of DNA are located in the 
Amplification Room of the Forensic Biology Unit. A calibration verification test and temperature non-
uniformity test are conducted on each thermal cycler approximately every six months. The verifications are 
conducted by an outside vendor. 
  

6.11. 3500 Maintenance 
 

OVERVIEW OF 3500 MAINTENANCE SCHEDULE: 
 
Weekly/Biweekly (recommended in the following order): 
Run the Wash Pump and Channels Wizard (weekly) 
Clean anode buffer cup pin-valve assembly (weekly) 
Place new Anode Buffer Container on instrument (Hard Stop) (bi-weekly) 
Replace Cathode Buffer Container (Hard Stop) (bi-weekly) 
Restart computer and instrument (weekly) 
 
Monthly: 
Flush the Pump Trap 
Replace septa on Cathode Buffer Container 
Clean the autosampler and drip tray 
Defragment Hard drives 
 
As needed: 
Replace Polymer 
Spatial Calibration 
Spectral Calibration 
Replace Capillary Array (also requires spatial and spectral) 
Pump cleaning 
 
Powering on the 3500 and launching the Data Collection software 
 
1. Power on the computer. At the Log On prompt, log in to the computer. 
 
2. Before turning on the 3500 instrument, ensure that the oven door is closed and locked, that the 

instrument doors are closed, and the computer is powered on. 
 
3. Power on the instrument by pressing the on/off button on the front of the instrument. Ensure that the 

green status light is on and not flashing before proceeding. 
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4. Click on the 3500 Series Data Collection Software 2 icon on the desktop. Log in to the data 
collection software with the password taped to the monitor.  

 
5. Use the Dashboard to review maintenance notifications. When you complete a task, click the green 

check mark to indicate that it was completed, or the red X to mark it as dismissed. 
 
6. Click on Maintenance on the top panel. Use the left panel to navigate to the schedule calendar or 

Maintenance Wizards to complete the needed maintenance. 
 
Weekly Maintenance 
 
At least 30 minutes prior to beginning weekly maintenance, bring Conditioning Reagent, POP-4 
Polymer*, Anode buffer container, and Cathode Buffer Container to equilibrate to room temperature.  
*If polymer remains before the expiration date, and there are still injections left in the pouch, polymer can 
be reused for a total of approximately four weeks on the instrument before it needs to be replaced.  
 
Run the Wash Pump and Channels Wizard 
 
This wizard takes about 40 minutes from start to finish. Click ‘Maintenance’ on the top panel, and 
‘Maintenance Wizards’ on the left to find the ‘Wash Pump and Channels’ wizard.  
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Follow the wizard prompts to empty the anode buffer (NOTE: The EMPTY anode buffer container is placed 
back on the instrument for the water wash), remove polymer, insert conditioning reagent, and insert 
polymer to flush the pump chamber and channels.  
 
Clean anode buffer container valve pin assembly 
 
Following pump chamber and channels wash, and before installing the new anode buffer container, use a 
clean lint-free cloth and deionized water to wipe clean the anode buffer container valve pin assembly on the 
polymer delivery pump.  
 
Place new Anode Buffer Container on instrument 
 
1. Remove Anode Buffer Container from outer plastic wrap. Ideally, this is done after the wash pump and 

channels wizard. 
 
2. Tilt it slightly to make sure that most of the buffer is in the larger side of the container. There should be 

less than 1 mL of buffer remaining in the small side of the container. Verify that buffer is to the fill line.  
 
3. Gently peel off the plastic seal on the top without spilling any into the small side of the container. If it 

does spill into the overfill side, pipette it back into the reservoir so that the liquid reaches the fill line.  
 
4. Place the Anode Buffer Container (label side first) under the valve pin assembly, and slowly slide the lip 

of the container into the locks.  
 
Replace Cathode Buffer Container (replacing septa only once per month) 
 
1. Remove Cathode Buffer Container from outer plastic wrap and peel off plastic seal from the top, 

ensuring that it is peeled off of every circular opening.  
 
2. Wipe off any buffer on top of the container with a lint-free cloth. Ensure that the top of it is dry.  
 
3. Press tray on the front of the instrument to bring the autosampler forward. Remove the old cathode 

buffer by pinching in the middle. 
 
4. Place the appropriate cathode buffer septa on both sides of the cathode buffer container. These only 

need to be replaced once per month. Septa can be washed with water and returned to the new cathode 
buffer. 

 
5. Install the new buffer by clicking it into the tabs on the autosampler.  
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6. Close the instrument door to re-initialize.  
 
Restart computer and instrument 
 
1. Close data collection software.  
 
2. Shut down computer. 
 
3. Once computer is shut down, press the power button on the instrument.  
 
4. Restart computer, but don’t log in.  
 
5. Once the computer is on, turn the 3500 back on by pressing the power again. Let the instrument 

initialize and wait for the solid green light to appear before logging on to the computer. 
 
6. Click on the 3500 Series Data Collection Software 2 icon on the desktop. Log in to the data 

collection software (it may take a minute for the connections to be reestablished before the software can 
open).  

 
Monthly Maintenance 
 
Flush the Pump Trap  
 
The water trap must be flushed once per month (or more often as needed) to prolong the life of the pump 
by cleaning any diluted polymer and clearing air bubbles. 
 
1. Fill the supplied 20 mL, all-plastic Luer lock syringe with nanopure water. Do not use a syringe smaller 

than 20 mL. Doing so may generate excessive pressure within the trap. Expel any bubbles from the 
syringe. 

 
2. Attach the syringe to the forward-facing Luer fitting at the top of the pump block. Hold the fitting with 

one hand while threading the syringe onto the fitting with the other hand. 
 
3. Open the Luer fitting by grasping the body of the fitting and turning it to loosen. Attached syringe and 

turn counterclockwise approximately one half turn. 
 

IMPORTANT! Do not use excessive force when you push the syringe plunger as this may damage the trap 
seals. Take approximately 30 seconds to flush 5 mL of nanopure water through the trap. 
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4. Remove the syringe from the Luer fitting. Hold the fitting with one hand while turning the syringe 
counterclockwise with the other hand. 

 
5. Close the Luer fitting by lightly turning clockwise until the fitting seals against the block. 
 
6. Dispose the excess water inside the overflow container. 
 
Replace septa on Cathode Buffer Container 
 
Once per month, change both of the septa on the Cathode Buffer Container during the weekly 
maintenance.  
 
Clean the autosampler and drip tray 
 
Wipe them down with a lint-free cloth and either deionized water or absolute ethanol 
 
Defragment hard drives 
 
Click the Windows Start icon to find Disk Defragmenter and open it. Click on each disk and click 
‘Analyze’ to determine the degree of fragmentation. Click ‘Defragment’ for every disk that is 
fragmented. This may take several minutes to hours depending on the degree of fragmentation. 
 
As Needed Maintenance 
 
Replace Polymer 
 
If there isn’t sufficient polymer to complete your run or if the polymer has exceeded 4 weeks use on the 
instrument, it is necessary to place a new polymer pouch on the instrument. Get a new polymer pouch and 
let it equilibrate to room temperature before replacing the old one. Use the Replenish Polymer wizard 
to complete this. Follow the wizard prompts in order to flush the pump of the old polymer and refill the 
capillaries with the new polymer. This wizard takes 10-20 minutes to complete 
 
Spatial Calibration 
 
The 3500 Series Data Collection software uses images collected during the spatial calibration to establish a 
relationship between the signal emitted by each capillary and the position where that signal is detected by 
the CCD camera. A spatial calibration is required to ensure correct alignment of the capillaries and optimal 
detection of the signal in each capillary. 
 
A new spatial calibration is recommended when: 
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 A capillary array is installed, replaced or temporarily removed from the detection block 

 The instrument is moved 

 The detection cell door is opened 
 
Perform Spatial Calibration and Evaluate Results 
 
1. Click ‘Maintenance’ on the Dashboard. Click ‘Spatial’ under the Calibrate heading on the left. 

 
2. Select No Fill, or select Fill to fill the array with polymer before starting the calibration. 

 
3. Click ‘Start Calibration’. The display updates as the run progresses. 

 
4. When the run is complete, evaluate the spatial calibration profile to ensure that you see the following: 

 One sharp peak for each capillary. Small shoulders may be acceptable. 

 One marker (+) at the apex of every peak. No off-apex markers. 

 An even peak profile (all peaks about the same height). 

 The Max Spacing – Min Spacing should be no more than 2 pixels. 
 
5. If the results meet the criteria above, click ‘Accept Results’.  
 
Note: If any peaks are lower than usual for the instrument or the heights drastically slope up or down, 
repeat the calibration with a fill. See below for an example of an acceptable Spatial Profile. 

 
 
6. Click ‘View Spatial Calibration Report’. 
 
Spectral Calibration 
 
A spectral calibration creates a matrix that corrects for the overlapping fluorescence emission spectra of the 
dyes. Although each of these dyes emits its maximum fluorescence at a different wavelength, there is some Not 
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overlap in the emission spectra between the dyes. The goal of multicomponent analysis is to effectively 
correct for spectral overlap and minimize the presence of artifacts, such as spectral pull-up, in the data. 
 
A new spectral calibration is recommended/required when: 

 The capillary array is changed (required) or temporarily removed from the detection block. 

 The instrument is moved. 

 The laser or CCD camera has been realigned/replaced by a service engineer. 

 An increase in (pull-up and/or pull-down peaks) is observed. 

 A new dye set is used on the instrument. 

 The capillary array length or polymer type is changed. 

 The detection cell door is opened (not required by the software, but recommended). 
 
Perform Spectral Calibration and Evaluate Results 
 
1. Pre-heat the oven by clicking ‘Start Pre-heat’. 
 
Note: Preheating for approximately 30 minutes helps mitigate subtle first-run migration rate effects. The 
pre-heat function automatically turns off after 2 hours. 
 
2. Click ‘Maintenance’ on the Dashboard. Click ‘Spectral’ under the Calibrate heading on the left 

panel. 
 

3. Check the pump assembly for bubbles and run the Remove Bubble wizard if needed. 
 

4. Vortex the appropriate Matrix Standard. Prepare the Master Mix: 
 
For GlobalFiler® and YfilerTM Plus analysis, use Dye Set J6.  

a. Standard: 10 μL 
b. HIDI Formamide: 290 μL 

 
Note: Volumes other than above may be used to obtain spectral peaks between 3000-10,000 rfu.  The total 
volume should not exceed 300uL.  
 
Note: After a capillary array is changed, a new spectral calibration must be run for each dye set.  
 
5. Load 10 μL of matrix standard/HIDI mixture into wells A1-H1 of a 96-well reaction plate. Note: 

multiple matrix samples (i.e., J6 or G5) can be run in subsequent columns on this plate if needed) 
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6. Cover the plate with a 3500 septa mat and centrifuge to ensure that the samples are at the bottom of the 
wells and place the reaction plate in the Veriti® thermal cycler. 

 
7. Denature the samples by running the spectraldenature protocol on the Veriti thermalcycler (95°C, 5 

min).  
 
Note: The cover plate of the Veriti® thermal cycler may be closed onto the septa mat-covered reaction 
plate, but do not clamp the cover down.  Although the lid is not heated during the denature protocol, it 
may stick to the septa mat and pull it up when the cover is opened if it is clamped down. 
 
8. After the denaturation protocol is finished, chill the reaction plate immediately in the 96-well cooling 

block (-20°C) for at least 3 minutes. 
 

9. Place the plate into a 3500 Series 96-well plate base (it will only fit in one orientation) and cover with a 
3500 Genetic Analyzer 96-well plate retainer.  Check to ensure that the retainer clip is properly seated. 

 
10. Press the tray button on the front of the 3500 Genetic Analyzer. When the autosampler tray presents 

itself, open the door of the instrument and place the tray onto the either position of the autosampler 
(the tray will only fit in one orientation). Tilt the plate toward the middle, first before lowering into the 
side clip. Close the instrument door. 

 
11. In the 3500 Series Data Collection Software 2, Click ‘Maintenance’ on the dashboard. Click 

‘Spectral’ under the Calibrate heading on the left. 
 

12. Select the number of wells (96), plate position, chemistry standard (Matrix Standard) and dye set (J6 or 
G5). Ensure that ‘Allow Borrowing’ and ‘Perform Run 2\Run3 if Run 1 Fails’ are deselected. 

 
13. Click ‘Start Run’. Run takes ~30 minutes to complete. Passing capillaries are shown in green and 

failing capillaries are shown in red. Borrowed capillaries are shown in yellow with an arrow indicating 
the adjacent capillary from which results were borrowed.  

 
14. Evaluate each capillary for the following: 

 Order of the peaks in the spectral profile from left to right: 
J6: blue, green, yellow, red, purple, orange (an example is below) 

 Peak heights are sufficiently robust (>2,000 RFU) and do not contain extraneous peaks, gross 
overlaps, dips, or irregular morphology. If peak heights exceed 20,000 RFU, set up another plate 
with a reduced amount of matrix standard. If peak heights are below 2,000 RFU, set up another 
plate with an increased amount of matrix standard. See below for an example of an acceptable J6 
spectral profile.G5 is similar, but without the purple.  
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15. If the results meet the criteria above, click ‘Accept Results’. If the results do not meet the criteria, set 

up another plate, adjusting amount of matrix standard, if necessary, and run again.  
 
Installing or replacing the capillary array 
 
It is recommended that the capillary array be replaced after 160 injections per capillary, or removed from 
the instrument for storage if the instrument is to be shut down for an extended period of time; however, 
capillary life may be extended based on the quality of the data obtained from the array. 
 
Select the ‘Install Array Wizard’ for guidance. This wizard takes 15-45 minutes to complete. 
 
Note: A spatial calibration AND spectral calibration are required after a capillary array change. The 
instrument will not run without a new spectral calibration associated with that capillary RFID tag. 
 
Removing bubbles from the pump block 
 
Periodically, check the pump chamber, channels and tubing for air bubbles.  Press the button on the right 
hand side of the front of the instrument to turn on the lamp inside the instrument. This will help locate any 
air bubbles. 
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Select the ‘Bubble Removal Wizard’ for guidance. This wizard takes 5-15 minutes to complete. 
 
Pump Cleaning 
 
In nearly all circumstances, the Water Wash Wizard is very effective in cleaning the pump assembly. 
Occasionally, a situation in which the Water Wash Wizard is not sufficiently effective may arise. If polymer 
has dried in the channels of the lower block, or if some contamination in the pump assembly is suspected, 
use the Pump Cleaning Kit to thoroughly clean the pump assembly.  
 
If this procedure is needed, refer to the Pump Cleaning Kit Protocol for 3500 Series Analyzers. 
 
REFERENCES: 
Applied Biosystems 3500/3500xL Genetic Analyzer User Guide 
Applied Biosystems 3500/3500xL Genetic Analyzer User Bulletin 
Product insert sheet from Dye Set J6 (Pub. Number 4426042 Rev. A) 
Pump Cleaning Kit Protocol for 3500 Series Analyzers 
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7.  COLLECTION KITS AND SUPPLY ORDERING 
 

7.1. PREPARATION OF EVIDENCE COLLECTION KITS 
 

The Forensic Biology Unit provides officers, investigators, and sexual assault nurses with six types of kits used in 
the collection of biological evidence.   
 
In general, the Laboratory Technician is responsible for preparing and disseminating the kits, however, the unit 
as a whole is responsible for these kits.  A point person may be assigned the responsibility of these kits.  A 
minimum stock should be kept on hand at all times in order to fill requests promptly.  Kit components should 
also be prepared and kept on hand.  Kits and kit components should be made on a sterile surface.  Use protective 
gloves and a laboratory coat when preparing and handling kits and kit components. 

 
7.1.1. REFERENCE MOUTH SWAB COLLECTION KITS 

 
Keep 60-100 kits on hand at all times. 
 
Place the following items in a Reference Mouth Swab Collection Kit envelope (a manila envelope with ‘SDPD 
REFERENCE MOUTH SWAB COLLECTION KIT’ printed on the front): 
 

 2 sterile, paper-wrapped swabs 
 1 small “SDPD Reference Mouth Swabs” envelope 
 1 smaller manila envelope 
 1 evidence seal 
 1 pair of large nitrile gloves 
 1 copy of ‘Instructions for the Collection of Reference Mouth Swabs’ 
 1 copy of the SDPD consent form 
 
Individual kits can be packaged together in large paper bags containing 20 kits. 

 
7.1.2. BIOLOGICAL STAIN COLLECTION KIT 

 
Keep 60-100 kits on hand at all times. 
 
Place the following items in a Biological Stain Collection Kit envelope (a manila envelope with ‘BIOLOGICAL 
STAIN EVIDENCE COLLECTION KIT’ printed on the front): 
 

 2 sterile, paper-wrapped swabs 
 1 tube containing sterile water 
 1 small ‘SDPD BIOLOGICAL EVIDENCE SAMPLE’ envelope  
 1 smaller manila envelope 
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 1 evidence seal 
 1 pair of large nitrile gloves 
 1 copy of ‘Instructions for the Collection of a Biological Stain’ 

 
7.1.3. FETAL TISSUE COLLECTION KIT 

 
Prepared as needed. 
 
Place the following items in a manila envelope: 
 

 2 blue-capped 50mL conical vials (1 is a spare) 
 Evidence seals 
 Procedure for collecting aborted fetal material 
 1 pair of large nitrile gloves 

 
 
A cooler and ice pack will be provided to any investigators for transporting the fetal material to the Property 
Room.  Reference mouth swab collection kits should also be provided to investigators for the purpose of 
collecting samples from the mother and alleged father. 

 
7.2. ORDERING AND RECEIVING COMMERCIAL KITS 
 

7.2.1. Ordering procedure 
 

Requests for supplies, reagents, and DNA typing kits will be placed in the Supply Order Log (electronic file) 
located on the department network (G:\Laboratory\Annaliese\Ordering, Quotes, POs\Ordering Log 
AHD.xlsx). 
 
When orders are placed, the date ordered and the order confirmation number will be logged into the Supply 
Order Log. 

 
7.2.2. Receiving supplies 

 
The receipt of the supplies will be logged into the Supply Order Log.  The packing slip received with the 
supplies is initialed and dated then submitted to the Administrative Aide in charge of purchasing for the 
laboratory. 

 
7.2.3. Receiving chemicals 

 
The receipt of the chemicals will be logged into the Supply Order Log.  The packing slip received with the 
chemicals is initialed and dated then submitted to the Administrative Aide in charge of purchasing for the 
laboratory. 
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A record of the chemicals on hand in the Forensic Biology Unit will be maintained.  Any new chemicals (i.e. 
not previously ordered/received) will require an MSDS to be on file in the Unit. 
 
Chemicals need to have the date and the initials of the receiver on the container. 
 

7.2.4. Receiving DNA kits 
 

The kits used for DNA extraction, quantification, and typing must all be recorded in the Kit Receipt Log upon 
receipt.  In general, the lot numbers of every component of the kit are recorded as well as the lot number of 
the kit.  Kit components may be stored in different locations and, thus, all kits components must be labeled 
with the laboratory-designated lot number (e.g., GF#-YY).   
 

7.2.4.1. QUANTIFILER KITS 
Record lot numbers of the PCR reaction mix, DNA standard, primer, and whole kit in the Kit Receipt Log.  
The PCR reaction mix should be labeled with the whole kit lot number and stored in the reagent 
refrigerator.  The remainder of the kit (in the original box) will be stored in the reagent freezer.  Place ‘Not 
QC’d, Do Not Use’ stickers on all kit components.  Replace with “QC OK” stickers once the quality control 
tests have been completed and reviewed. 

 
7.2.4.2. STR TYPING KITS 
Record lot numbers of all components of the kit and the whole kit lot number in the Kit Receipt Log.  The 
PCR reagents box should be labeled with the laboratory-designated lot number and stored in the reagent 
refrigerator.  The ladder will be labeled with the laboratory-designated lot number and stored in the reagent 
freezer in the Amplification Room. Place ‘Not QC’d, Do Not Use’ stickers on all kit components.  Replace 
with “QC OK” stickers once the quality control tests have been completed and reviewed. 

 
7.2.4.3. QIAGEN DNA INVESTIGATOR KITS (EZ1 or QIAsymphony) 
Record lot numbers of all kit components, except the buffers and proteinase K, and the whole kit in the Kit 
Receipt Log.  Discard the proteinase K and buffers.  Place ‘Not QC’d, Do Not Use’ stickers on all kits until 
quality control testing has been completed.  Replace with “QC OK” stickers once the quality control tests 
have been completed and reviewed. 
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